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About this guide

This guide provides configuration and implementation information for the integration of Infor CloudSuite
Business with Infor Operating Service (OS).

Use this guide in either of these cases:

* CloudSuite Business and Infor OS are both installed on-premises
* CloudSuite Business is installed on-premises and Infor OS is in the cloud.

Intended audience

This guide is intended for the system administrator or consultant who configures CloudSuite Business
for use with Infor OS.

Contacting Infor

If you have questions about Infor products, go to the Infor Xtreme Support portal.

If we update this document after the product release, we will post the new version on this website. We
recommend that you check this website periodically for updated documentation.

If you have comments about Infor documentation, contact documentation@infor.com.
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Requirements

Ensure that all requirements are met.

Required products

Ensure that you have installed and configured these products:

CloudSuite Business 9.01 or later
See the Infor CloudSuite Business Installation Guide.

Infor Operating Service release 12.0 or later

If you are using Infor OS in the Cloud, with CloudSuite Business on-premises, you must install the
Enterprise Connector locally, as part of the configuration steps in "Connecting the ERP to ION" on
page 35. See the Infor ION Desk User Guide - Cloud Edition for the Enterprise Connector server
prerequisites.

If Infor OS is installed on-premises, the server where you install Infor OS must be able to connect
to the servers where you install CloudSuite Business and other BOD-enabled products.

SAML Session Provider is installed with Infor OS and must be configured correctly for your application.
See the Infor Operating Service Installation Guide.

Optionally, CloudSuite Business Analytics
The installation of CloudSuite Business Analytics includes content for these products:

* Infor Bl release 11.1 or later
* In-context Bl

See the Infor CloudSuite Business Analytics Installation and Configuration Guide.

Required information

Obtain this information before you begin the integration:
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Requirements

* Credentials to connect to the application interface, for example, database user, password, server
name, port or instance.

* Name of the CloudSuite Business instance or logical ID that is used to connect with ION; tenant ID
that is used to connect the application to Infor OS in ION; and enterprise organization structure, that
is, accounting entities.

See"Setting up BOD replication and logical IDs, tenants, accounting entities, and locations in the
ERP" on page 32 for information about how to set up the logical ID, tenant ID and accounting entities
for your application.

+ CloudSuite Business sites that are used in the integration, and either the queue server name or the
bootstrap site that is used to communicate with the sites through replication inboxes and outboxes.

* Names of physical locations where your CloudSuite Business databases exist, if your company has
mutiple physical locations.

+ An administrator account for Infor Ming.le and ION.
» Location or source of files to be imported into ION and Infor Ming.le for content.

10 | Infor CloudSuite Business Configuration Guide for Infor Operating Service



Configuration checklist

Follow this checklist to integrate this application with the components of Infor Operating Service:

Complete Task Reference

a Collect all of the documents listed in the
Reference column from Infor Xtreme. These
documents could provide helpful back-
ground during this configuration.

a Understand the concepts of ION and BODs, Infor ION Desk User Guide
and how these concepts relate to this appli-
cation.

a Review the description of how this applica- "Integration with other applications through
tion interacts with Infor OS. ION" on page 17

"Concepts and definitions specific to this
configuration" on page 19

d Configure your application for Single Sign "Configuring your application for Single Sign
On: On" on page 21
» Set up your application to use Single
Sign On.
* Install Windows Identity Foundation
« Setupthe Web client with AD FS access
+ Edit the web.config file.

* Create arelying party trust for Infor Ming.
le and CloudSuite Business.

» Configure Active Directory authentication
groups.

* Import a security certificate for each user
computer.

» Set the time out option for all applica-
tions.

d Configure your web browser: "Configuring your browser" on page 27

* Allow popups

Infor CloudSuite Business Configuration Guide for Infor Operating Service | 11



Configuration checklist

Complete Task

« Set up compatibility for Internet Explorer
browsers.

Add your application in Infor Ming.le.

Configure your application and ION to send
and receive BODs:
« Configure this application for ION

+ Configure a connection point for this
application.

* Setup adocument flow to pass user and
role information

*  Publish BODs.

» Verify that the BODs are received in
ION.

Configure user access to your application
through Infor Ming.le:

« Configure user access to your applica-
tion in Infor Ming.le.

* Configure system administration access
to your application through Infor Ming.le

« Set up roles or groups.

« Optionally, add accounting entities and
locations to the users or roles.

» Optionally, set up distribution groups.

Set up ION APIs for your application

Configure drillbacks to your application.

Configure context and utility apps that are
used with your application

Configure homepages for your application

Optionally, configure workflows and ION
messages for your application.

Configure your application to work with Infor
Document Management:

+ Set up the IDM connection in CloudSuite
Business.

Reference

"Configuring your browser" on page 27

"Configuring your application and ION to
send and receive BODs" on page 31

"Configuring user access to your application
through Infor Ming.le" on page 43

"Setting up ION APIs for your product" on
page 51

"Verifying drillbacks to the ERP" on page 61

"Configuring context apps and utility apps
that are used with the ERP" on page 65

"Verifying Homepages for the ERP" on page
71

"Configuring workflows and ION messages
for the ERP" on page 53

"Configuring Infor Document Management
to work with the ERP" on page 75
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Configuration checklist

Complete Task Reference

¢ Activate the IDM workflows in CloudSuite
Business.

* Import the definitions in IDM.

« Enable the Related Information context
app for your application.

* Verify the configuration.

[ Configure Bl and Analytics content for your "Configuring Bl and Analytics content for the
application ERP" on page 83
« Configure access to Bl Infor CloudSuite Business Analytics Installa-

+ Configure In-Context Bl tion Guide

+ Configure Analytics
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Overview

Before you complete the configuration tasks, you must understand how this application is used with
Infor OS. You should also be familiar with a list of related concepts and definitions.

Infor OS

Infor Operating Service is a technology platform that supports fully integrated, industry-specific solution
suites with mobile-first design, a consumer-inspired user experience, and science-driven analytics. It
leverages the convergence of information, analytics, cloud computing, mobility, and social business.

This platform includes these products:

+ Infor Ming.le™

* Infor ION

* Infor ION Grid

* Infor Document Management
* Infor Business Vault

* Analytics

* Infor BI

Infor Ming.le

Infor Ming.le is a web-based application framework that provides a common user interface for Infor
applications, third-party applications, and in-house developed applications integrated through Infor ION
. Itis a centralized platform for social collaboration, business process improvement, and contextual
analytics.

Infor Ming.le provides drillback capability so that users can navigate across the applications to track
transactions, the transfer of data, and report updates. Additionally, Infor Ming.le provides an infrastructure
for sharing content with context applications.
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Overview

Infor Ming.le uses Homepages, configurable by users to organize information and activities at a high
level to focus on critical areas of concern.

Within Infor Ming.le, you can use ION API, a managed API layer across all applicable Infor and non-Infor
APIs, allowing existing APls to be presented in a standardized, managed, and controllable way.

Infor Ming.le uses Infor Federation Services (IFS) for centralized authentication.

Infor Ming.le is available as a mobile app, supported by iOS, Android™, and Windows Mobile operating
systems.

Infor ION

Infor ION is a business process management platform that integrates applications, people, and business
processes. The ION platform converts data into the common language of standardized XML to enable
disparate business systems such as Infor products, third-party applications, and in-house developed
applications to share information.

ION simplifies the connectivity and data sharing across the connected applications. It enables users
to configure a routed infrastructure, set up workflows, and design and activate business event monitors
and manage tasks and alerts.

ION components
Infor ION has these components:

» With ION Connect, you can establish connections between applications which can either be Infor
applications or third party applications. You can configure ION Connect through the ION Desk.

+ |ON Desk is an intuitive, browser-based interface used to easily configure and monitor the ION
Service.

In ION Desk, you can model document flows between applications. Such flows can represent a
business process. More technical flows can also be defined. For example, mapping data from a
third party application to a standard business object document as used by an Infor application. You
can also use filtering or content-based routing.

From ION Desk you can deploy your models to ION Service by activating them. ION Service will
then handle your documents in accordance to your activated models. ION Desk also provides
management screens to monitor the behavior of ION Service and to help in troubleshooting when
needed.

* In ION Event Management you can monitor business events and create alerts when exceptions
occur.

The start point of monitoring are the business object documents that are published by applications
when business events occur. Monitors are processes that run in the Event Management engine and
evaluate these documents by applying pre-defined business rules.

There is a predefined set of business rules that the monitoring engine can apply: comparison
conditions, value change conditions, and document overdue timer based rules. When exceptions
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are detected, these are reported as alerts to the business users. The distribution list of alerts is part
of the monitor definition.

+ ION Workflow is used to model and run business processes such as authorizations, work distribution,
or task-driven workflows across several components.

For authorizations, you can use an approval workflow to approve a purchase order or to sign off a
new item. Such workflows are triggered by the creation of a new item or the submission of a new
order.

In the area of work distribution, the workflow ensures that all tasks for a certain event are being
distributed and executed by different users. The advantage of using the ION Workflow is that you
can model how these tasks are performed, for example sequential or in parallel.

* |ON Pulse is the component that ensures the communication to the end user. ION Pulse manages
the Alerts, Tasks and Notifications and distributes them to users. When users take actions in Infor
Ming.le, ION Pulse records these actions and returns the reply to the engine that generated the
user activity. ION Pulse is also the component that sends email notifications for Tasks, Alerts, and
Notifications.

For more information about these components, see the Infor ION Desk User Guide.

To understand common ION concepts such as BOD nouns and verbs, document flows and workflows,
listeners and connection points, see the ION Connect Concepts chapter in the Infor ION Desk User
Guide.

Integration with other applications through ION

An outbound operation typically begins when a user performs an action in CloudSuite Business that
requires a data exchange with another ION-enabled application. A Business Object Document (BOD)
XML message is generated by CloudSuite Business and placed in an area designated as the Cloud
Suite Business message outbox. At scheduled intervals, ION connects to the outbox and retrieves the
BODs from it.

In ION Desk, you create application connection points. The connection point defines the information
needed to connect to the application database. It also holds a list of all the BOD documents that the
application can send or receive.

You define document flows between CloudSuite Business and other applications represent the business
flows between the applications. For example, you set up a document flow between CloudSuite Business
and Infor Ming.le to pass BODs that contain user and role information. Use the Modeler in ION Desk
to define these document flows. Use the Modeler in ION Desk to define these document flows.

ION routes BODs according to the document flows between BOD-enabled products. If a document
flow is defined from CloudSuite Business to another application for a particular BOD, then at specified
intervals, ION places the outbound BOD from CloudSuite Business in the other application’s designated
message inbox. Products are responsible for validating and incorporating the data in inbound BODs
according to their rules.

If a document flow is defined from CloudSuite Business to another application for a particular BOD,
then at specified intervals, ION places the outbound BOD from CloudSuite Business in the other
application’s designated message inbox. Products are responsible for validating and incorporating the
data in inbound BODs according to their rules.
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If a flow is defined from another application to CloudSuite Business, ION retrieves BODs from the
sending application’s message outbox and delivers them to CloudSuite Business’s message inbox for
processing. CloudSuite Business retrieves, validates, and processes the BODs.

Infor ION Grid

Infor ION Grid is a Java-based application server that provides a distributed runtime environment for
other applications. Those other applications may, at any time, be added (deployed) or removed
(undeployed) from a grid. The distributed nature of a grid means that an instance of the ION Grid may
span multiple server machines.

See the Infor ION Grid Administration Guide for administration tasks such as monitoring, configuring,
or managing the grid.

Infor Document Management

Infor Document Management (IDM) is an integration platform that enables you to take advantage of
document solutions already in use within your organization.

Infor Document Management is used to integrate your documents with your business processes and
to provide a central repository for them. Soft links are used, based on document metadata, to provide
integration between your documents and your Infor ERP solution. You can view a document from within
the context of your application, or click a document link to retrieve the document from the central
repository.

Infor Document Management supports the entire lifecycle of your business documents, from input
through storage, retrieval, and sharing.

Infor Business Vault

Infor Business Vault is a software platform for data acquisition and enrichment. The business data
repository contains one or many data stores populated by Business Vault software, and the data stores
are available for searching data, running reports, and synchronizing data.

Analytics

CloudSuite Business Analytics provides industry-specific content for the Infor Bl solution for CloudSuite
Business. CloudSuite Business Analytics uses the Infor Bl component, Application Studio, to enable
access to the dashboards and widgets.

CloudSuite Business Analytics contains these components:
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* Business Measurement Models (BMMs)
BMMs extract and transform the source data into an analytical data model that contains fact tables
and dimension tables.

* Online Analytical Processing (OLAP) cubes

The OLAP cubes summarize data along defined dimensions and hierarchies. The cubes also contain
dimensions for time and time-series analysis, making it easy to compare years or periods on various
levels.

+ Dashboards and widgets

Infor BI

Infor Bl supports all typical internal and external business intelligence requirements, with flexible ad
hoc analysis and planning.

The BI solution suite is predominantly used where highly specific business needs must be fulfilled.
Usually, the solution is based on a multidimensional OLAP approach and uses dashboards and widgets
for reporting.

Concepts and definitions specific to this configuration

To configure the tenant, logical ID, accounting entity and location correctly, you must understand these
terms and how they are defined in this application. Together, these terms determine where inbound
BOD information is processed, or the outbound instance and location to which the BOD information
should be associated.

Tenant ID

The tenant is a container for accounting entities and locations and is required in each BOD. The value
of the tenant must be the same in all of the products that exchange BODs. Data is not shared or
accessible between tenants.

See the information about using tenants in the Infor ION Desk User Guide.

For an on-premises configuration, verify that all of the other products are using the default value of
infor for the tenant ID, and if so, use that as your tenant ID for CloudSuite Business.
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Accounting entity

An accounting entity usually represents a legal or business entity that owns its general ledger. Every
transaction belongs to only one accounting entity. An accounting entity can also be defined as the
owner of certain master data among the enterprise. CloudSuite Business is the system of record for
accounting entities.

For CloudSuite Business, the site is used as the accounting entity.

Do not confuse this Infor definition of “accounting entity” with the CloudSuite Business definition of
“entity,” which is a type of site that is used only for financial consolidation.

Location

A location is the physical location that is associated with data or transactions. The location can be, for
example, a warehouse, a manufacturing location, a project location, or an office. Locations are published
in the Location BOD. A location is required for all transactional BODs and is usually the location from
which a transaction or record is generated. CloudSuite Business is the system of record for locations.

Logical ID

The logical ID is a unique identifier used in the communication of data between the applications in the
tenant’s environment. Each instance of an application, for example, a site, is assigned one logical ID.
In ION, the logical ID is used to properly route BODs. Infor Ming.le uses the logical ID to determine
which application to start when you click a drillback.

This logical ID is defined in the CloudSuite Business Sites/Entities form. You must provide the logical
ID when you define the ION connection point for on-premises applications.

In Infor Ming.le, each application is assigned a logical ID. Infor Ming.le supports only one logical ID per
application.

For more information, see the CloudSuite Business online help.
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Sign On

Single sign on allows users to use one set of credentials to log into all Infor applications.

CloudSuite Business is set up for Single Sign On in Infor Ming.le through the use of SAML authentication,
Microsoft AD FS and Integrated Windows Authentication. This requires an environment where a
Windows domain trust between the client systems and the ADFS host is configured.

See the Infor Operating Service Installation Guide for information about the client Single Sign On
experience and about the SAML session provider.

Setting up your application to use Single Sign On

Use these steps to set up Single Sign On between the Infor Ming.le portal and CloudSuite Business.

Installing Windows Identity Foundation

Windows Identity Foundation 3.5 must be installed on the AD FS server and the CloudSuite Business
utility server. Parts of this are installed during the CloudSuite Business installation, but the full feature
must be installed in order to use SSO.

See the Infor CloudSuite Business Installation Guide for information about setting up CloudSuite
Business to work with AD FS.

Setting up the Web client with AD FS access

The CloudSuite Business Web client can run as an application inside the Infor Ming.le shell. Be aware
that there are some differences between the CloudSuite Business Web client and the smart client.
These differences are documented in the CloudSuite Business online help.
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Ensure that these Web client requirements are met:
1 Install a CloudSuite Business Web client on a server, as described in the Infor CloudSuite Business
Installation Guide.

2 In order to access online help from CloudSuite Business in Infor Ming.le, install the utility server
where the help files reside on the same physical server where the Web client is installed.

3 Follow the steps to set up Web rendering with AD FS as described in the Infor CloudSuite Business
Installation Guide.

4 In the CloudSuite Business Configuration Wizard, select AD FS as the authentication type.
5 In AD FS, create a relying party trust and give it the appropriate claims rule.

6 In AD FS, add all of your CloudSuite Business users, which will allow automatic login to CloudSuite
Business through Infor Ming.le.

7 Verify that you can log in to the Web client configured with AD FS. Take note of the URL that you
use to log in, because you will need it for a later step.

Editing the web.config file

By default, the CloudSuite Business web client only renders URLs that are on the same server as the
web client.

Edit the web.config files in both of these locations under the inetpub/wwwroot folder on the utility server:
+ WSWebClient

* |IDORequestService

To accept URLs from other locations, remove these associated tags in the web.config files:

*+ Remove the tag <add name="X-Frame-Options" value="SAMEORIGIN"/>

*+ Remove the tag <add name="Content-Security-Policy" value="frame-ancestors
'self';"/>

Alternatively, you can edit these entries to add servers for more security. For example, add a value of
“frame-ancestors ‘self’ https://mingleserverurl.com”. The web.config file can also
accept wildcards such as “frame-ancestors ‘self’ https://*.infor.com”.

Creating a relying party trust for Infor Ming.le and the ERP

This task uses a Power Shell script to create a relying party that associates Infor Ming.le with AD FS
for Single Sign On.

This Power Shell script is similar to the Power Shell scripts that you ran in the post-installation steps
of the Infor OS installation. See the Infor Operating Service Installation Guide.

1 In Infor OS Manager, open the Applications section.
2 Add an application and specify this information:
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Application Name and Description
Specify a name of your choice that identifies the application.

Application Type

Select SYTELINE(SyteLine).

Relying Party Identifier

Specify a unique ID in this format, where URN is a name of your choice that identifies the application
and party ID:

Urn: URN :Syteline

For example, Urn:Infor_CloudSuite:Syteline.

SSO URL and SLO URL
For both options, specify the Web client URL, for example: https://sl server/WSWebClient/
where sl_server is the CloudSuite Business web server.

Signing Certificate
Leave this field as (none).

w

Save your changes.

H

Click the arrow next to the new application and specify a location to download a Power Shell script
that is generated from this information.

Copy the Power Shell script to the AD FS server.
Open the Windows PowerShell as an administrator.

N O O

Run the Set-Execution Policy Unrestricted command and specify Y to confirm the Execution
Policy. Press Enter.

(=]

Run the PowerShell script that you downloaded.

©

Configure Forms Authentication:
a Open ADFS Management and click Authentication Policies.
b Click Edit in the Primary Authentication section.

¢ Select Forms Authentication for Extranet and Intranet, clear Windows Authentication for
Intranet, and click Apply.

Configuring Active Directory authentication groups

For access to the Infor Ming.le and CloudSuite Business sessions, you must associate all users’ domain
accounts with these predetermined Active Directory security groups:

Infor application Active Directory security group
Infor Ming.le Infor
CloudSuite Business CloudSuite Business Users

Create these security groups in Active Directory outside of Infor Ming.le. See the Microsoft documentation
about Active Directory for information about how to configure user accounts with security groups. Also
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see the Infor CloudSuite Business Installation Guide for information about how to configure CloudSuite
Business for use with Active Directory.

Importing a security certificate for each user computer

To allow AD FS Single Sign On to Infor products, you must obtain a certificate that your users can add
to their computers by using the Microsoft Management Console.

To import the certificate to a user’'s computer:

From the Windows menu, select Run and enter mmc.
Select File > Add/Remove Snap-in.

Select Certificate and click Add.

Select Computer Account and click Next.

Expand Certificates.

Right-click Trusted Root Certificate Authorities.
Select All Tasks > Import and import the certificate file.

N OO A WODN -

Single Sign Out

When a user signs out of a portal such as Infor Ming.le, the user is automatically logged out of all
applications, context applications, and widgets that were opened by the user through the portal.

Setting the timeout option for all applications

Use the Time-out option in Infor Ming.le to configure the idle session time-out value for all the Infor
applications that are accessed through the Infor Ming.le portal. This time-out value applies to all users
and applications in Infor Ming.le. User activity is updated periodically by each application through a
common cookie in the root DNS domain. If no user activity is logged within the period specified in the
time-out value, the user is automatically logged out of all applications.

1 From the Infor Ming.le User Management menu, select Security Administration > Session
Configuration.

2 Click Time-out and configure the idle session time-out value to use for all Infor applications that are
accessed through the Infor Ming.le portal. The time is measured in minutes, and you can specify a
number from 10 to 470.

3 Configure a session timeout value for the CloudSuite Business web client that is at least as long as
the Infor Ming.le timeout value. Set the timeout value in the Web.config file located in the
WSWebClient 1S application folder on the CloudSuite Business utility/web server. For example, to
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set the CloudSuite Business web client session timeout to 60 minutes, use this element and attribute
value:

<sessionState mode="InProc" timeout="60">
</sessionState>

Infor CloudSuite Business Configuration Guide for Infor Operating Service | 25



Configuring your application for Single Sign On

26 | Infor CloudSuite Business Configuration Guide for Infor Operating Service



Configuring your browser

Configure your browser for use with Infor Ming.le.

Allowing popups for browsers

Ensure that any browser that is used with CloudSuite Business allows pop-ups. If pop-ups are disabled,
the help will not work properly.

Avoiding multiple connections in a browser

You can have as many configurations as you want in a single application or server instance.

However, you cannot have multiple concurrent connections to the same CloudSuite Business application
server in a single browser, even using different configurations. The session connection attributes use
the server name as the key and are not differentiated by configuration name.

Setting up compatibility for Internet Explorer browsers

Note: Follow these steps only if you are using Internet Explorer as your browser.

Some Infor Ming.le and CloudSuite Business versions of Internet Explorer might be incompatible. If
s0, a message is displayed to indicate that your browser is not supported. In that case, before you can
run CloudSuite Business in Infor Ming.le, you must change your compatibility view settings in your
browser.

1 In the browser, click Tools > Compatibility View Settings.
2 Clear the Display intranet sites in compatibility view option.
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Perform these steps to add CloudSuite Business as an application that can run in Infor Ming.le:

1 From the Infor Ming.le user menu, select Admin Settings.
2 Click Add Application.
3 Use this information to complete these fields:

Application Type
Specify Infor Application.

Application Name
Select your application name and version from the list.

Display Name
Specify CloudSuite Industrial.

Logical ID

The first part of the logical ID is set automatically based on the application name. Specify the rest
of the logical ID for the CloudSuite Business instance associated with this instance of Infor Ming.le
, for example, the site name. This ID must be lowercase and not contain special characters.

Application Icon
Click Choose Icon.

Each application has a default icon. You can only select the color which you want to apply to the
icon.

Use Https
Select this option if SSL is enabled for the CloudSuite Business user interface. If CloudSuite Business
is using SSL, ensure that you specify the SSL-related port number in the Port # field.

Host Name
Specify the name of the CloudSuite Business web/utility server. This host name is also used for
drillbacks to the application.

Also, if you use a fully-qualified name, for example, server.infor.com, in one instance, you must
use it for all instances.

Note: The host name entered in Infor Ming.le must exactly match both the web server referenced
in the Application URL specified in the Web rendering section of the CloudSuite Business
Configuration Wizard and the host name specified on the server’s security certificate. The URL
names are case-sensitive.
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Port #
Specify the port used by the CloudSuite Business web/utility server. Typically this is 80 for HTTP,
and 443 for HTTPS.

Context
If any context is defined in the Infor Registry, it is shown as the default context when you select the
Application Name.

Default Tenant
We recommend that you specify Infor.

4 Click Save.
5 Review the default values in these tabs:

Deployment Information: The connection information you specified for this application is
displayed.

Permissions: Two default roles are created, Infor-SystemAdministrator and MingleAdministrator.
Additional roles are automatically generated that match the default authorization groups in Cloud
Suite Business.

Later in the configuration process, you will use the Permissions tab to configure user access to
CloudSuite Business through Infor Ming.le.

Context/Utility Apps: The default context apps that are included with your application are listed
on this tab.

See "Context and utility apps that work with the ERP" on page 67.

You can add other context or utility apps here, including context apps that are unique to your
application.

By default, all the required applications are enabled and optional applications are disabled. You
can enable or disable context applications at any time.

Custom Parameters: Default custom parameters, if any exist, are displayed. You cannot edit
the default name of the custom parameter.

Logical ID Fallback: By default, no logical ID fallbacks are displayed.

Default values are generated when the application is created. Do not change the default values.

6 Click Save.
7 Verify that you can access the CloudSuite Business application from the App Menu.

8 Verify that you can log in to the CloudSuite Business app as the “sa” user.
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send and receive BODs

This section describes how to configure your application to communicate with ION. Integrations between
this application and other applications use ION to send and receive BODs. For details about a specific
integration, see the appropriate integration guide.

Configuring your application for ION

You must set up this application so that it can generate BODs and place them in a message outbox
where ION can retrieve them.

You must also set up the inbound message configuration, so that BODs sent to this application can
process those messages.

Verifying that the SQL Server no count option is not set

In order to receive all of the BODs from ION into CloudSuite Business, the no count option must be
cleared in SQL Server Management Studio:

1 In SQL Server Management Studio, right-click on the CloudSuite Business database server name
and select Properties.

2 Select the Connections page.

3 In the Default Connection Options section, clear the no count option.

4 Click OK.

Setting master data to standardized values

To ensure consistent master data between integrated products, use the ISO standard values where
applicable.

Infor CloudSuite Business Configuration Guide for Infor Operating Service | 31



Configuring your application and ION to send and receive BODs

You can map existing non-standard units of measure, currencies and countries to ISO values through
these CloudSuite Business forms:

* Currency Codes

Note: ISO currency codes are required for some integrations. ISO currencies are not defined as
part of an initialized database and must be set manually.

« Countries
¢ Unit of Measure

Setting up a default configuration for each site

On the Sites/Entities form, specify a default Configuration Name for the site. You must create a
configuration with this name, which will be mapped to this site record.

Alternatively, if you leave this field blank, you must create a configuration whose name exactly matches
the local site name, including the capitalization. For example, if your local site name is oh, you must
create a configuration named oh. You can use the Copy feature of the Configuration Manager utility
to create this configuration.

Stop and start all Infor services after you create the configuration.

Setting up BOD replication and logical IDs, tenants, accounting
entities, and locations in the ERP

Use these steps to configure information that is required for BOD replication in CloudSuite Business.

Note: After you perform these steps on one site, some information is replicated to the other linked
sites.

1 If multiple sites on a CloudSuite Business intranet will send or receive BODs, make sure that
replication is set up between the sites as specified in the Infor CloudSuite Business Multi-Site
Implementation Guide. The sites must be replicating the Site Admin category to each other. On the
Sites/Entities form at each site that will send or receive BODs, verify that all of the other sites are
linked to this site.

2 On the Intranets form, to create a new intranet for Infor ION (bus), specify these values:

Intranet
Specify the name to identify the intranet, for example, InforBUS.

Description
Specify an appropriate description, for example, Infor ION connection.

External
Select this check box.
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Transport
In this field on the General tab, specify ESB.

On the Intranets form, select the intranet used by your CloudSuite Business site and specify this
information:

Transport
Specify HTTP.

Queue Server

Optionally, specify the name of your MSMQ Server. You only need to specify a special queue name
here if your site names are not unique, or if the MSMQ is on a different machine than the utility
server. The queue server name can encompass both the name of the machine and the prefixed
names of the queues.

If this field is left blank, the default queue server names are used.

Tenant ID

To use the same tenant ID for all sites on this intranet, specify it here. You can also leave it blank
here and specify the tenant ID on the local site records, or leave that field blank to use the default
tenant ID value of infor. The tenant ID can be a maximum of 22 characters and must match the
tenant ID used in ION for other connecting products. For more information about how the tenant
ID is used with ION, see the Infor Operating Service Administration Guide.

On the CloudSuite Business utility server, specify configuration information on the Replication tab
of the Service Configuration Manager utility:

* Inthe Replicator/inbound Bus Configurations field, specify all of the configurations that can
receive inbound or outbound messages from other sites on the intranet. The Replication Document
Outbox form at each site collects outbound BODs for that site. The Replication Document Inbox
form at each site collects inbound BODs for that site.

* Inthe ReplQListener Queue Servers field, set up a queue server name for every intranet in
your system.

Generally, the queue server name is set to localhost\private$ which uses the standards private
message queues named inbound and outbound on the utility server. However, if you have
specified a Queue Server Name on the Intranets form, that name is used to build a path. For
example, utilityserver3\private$\MyQueues results in the use of the queue names
MyQueues_inbound and MyQueues_outbound.

Note: If you are upgrading from a previous version and you already have replication set up through
a “bootstrap” site, it will still work as it did in the previous version. The Replicator/Inbound Bus
Configurations field contains one site set as the Master Site, and the ReplQListener Queue
Servers field has the Default field selected.

On the Sites/Entities form, create a logical "site" for ION:
Site
Specify a name to identify this site as your ION site, for example: InforBUS.

Site Name and Description
Specify an appropriate site name and description.
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Type
Specify Site.

Intranet Name
Select the intranet you created in step 3.

From Site
On the Site User Map tab, specify the local site, for example, oh. The site name is used as the
accounting entity in BODs.

User Name

Specify the user ID used to send replication documents to the CloudSuite Business outbox for ION
to retrieve. This user must already be set up on the CloudSuite Business Users form at the local
site. We recommend that you specify the repl_user here, if it is defined. Otherwise, specify a user
with Full User editing permissions. Also, the Automation license module must be assigned to the
user that you specify here.

6 On the Sites/Entities form, configure the local site, for example, oh, to generate or receive business
object documents (BODs).

a Specify the Message Bus Logical ID for the site. This identifies the CloudSuite Business site
to ION.

Specify the logical ID as tenant.syteline.site where fenant is the tenant ID, syteline is the
application type, and site is the name of the local site, for example infor.syteline.oh. The logical
ID must be all lowercase.

Note: The logical ID entered here must match the application type and name defined in the ION
connection point for this CloudSuite Business site.

b Optionally, specify a Tenant ID for the local site. If no tenant ID is specified here or on the Intranets
form, the default tenant ID value is infor.

7 At each site that is sending or receiving BODs, open the Replication Rules form and create a new
rule. Specify this information:

Source Site
Specify the local site that you configured in Step 6.

Target Site
Specify the ION site that you created in Step 5.

Category
Specify ESB.

Interval Type
Specify any option except Transactional.

8 At each site that is sending or receiving BODs, open the Replication Management form and click
Regenerate Replication Triggers.

Note: If you have multiple sites in one database, you only need to perform this step at one site.
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Setting up information that will flow to other products

The values that you configure in CloudSuite Business - for example, customer, vendor or item master
records, or system parameters — often depend on the application with which CloudSuite Business will
exchange information. For more information, see the appropriate application integration guide.

Verifying BOD replication

To verify that replication is set up properly:

1 On the CloudSuite Business utility server, stop and start the Replication and Replication Queue
Listener services.

2 In CloudSuite Business, open a form whose information is being replicated to ION. For example,
the Vendors form information might be replicated.

3 Change a value and save the record. For example, you could change the vendor address.

4 Check the Replication Document Outbox form to see if a BOD was generated and marked as
processed. In our example, the SyncSupplierPartyMaster BOD is generated.

After CloudSuite Business is connected to ION, the BODs might be removed immediately from the
outbox after ION retrieves them. In that case, open ION Desk and select Manage > OneView to
verify whether the BOD was sent and processed.

Connecting the ERP to ION

A connection point must be set up for CloudSuite Business.

You can then set up and activate document flows that send BODs from the CloudSuite Business
connection point to other applications' connection points, or that receive BODs from other applications'
connection points.

Understanding connection points and document flows

You create connection points in ION Desk. Connection points provide the information that ION uses
to connect to an application’s message inbox and outbox. At least one connection point must be defined
for each application instance that integrates to ION.

For each connection point, you select the BOD documents that can be sent or received by the application
instance. These correspond to the BODs that are listed in "BODs used in integrations with this
application" on page 103.

In an integration between two BOD-enabled applications, document flows are set up to define the BODs
that flow between the application connection points.
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A connection point can be reused multiple times in one or more document flows. You can also create
connection points during the modeling of a document flow in the details section of the document flow
elements. The connection points that are created during the modeling of a flow are added to the shared
list of connection points, and they can be reused.

Some integrations with CloudSuite Business use a solution XML file to set up sample connection points
and document flows. This file can be imported to ION to provide the basis for connection points and
document flows.

See the section on ION Connect Modeling in the Infor ION Desk User Guide for additional information
about connection points and document flows.

Using the Enterprise Connector in a hybrid environment

If you are using an on-premises version of CloudSuite Business, withInfor OS in the cloud, first see the
“Enterprise Connector application connection points” section of the Infor ION Desk User Guide - Cloud
Edition. Use that guide to create locations for your on-premises application and to download, install,
and configure the Enterprise Connector in each of those locations.

Then follow the steps in this section to create your CloudSuite Business connection points, one for
each site, and associate each connection point with a location. Use the appropriate integration guides
to set up document flows between the ERP and other applications.

Creating an ERP connection point

1 In ION Desk, add a connection point for each instance of the application.
See the Infor ION Desk User Guide.
Use this information to complete these fields:

Name
Specify the CloudSuite Business site ID.

Type
Specify Infor Application.

Logical ID Type

Specify syteline.

Tenant

Specify a tenant, or leave blank to use the default tenant infor.

Database Driver
Specify SQL Server (Microsoft).

2 Specify the CloudSuite Business application database connection details, including the database
server, port, schema, and connection credentials. Other advanced settings are available.
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3 Select Delete Processed Messages to immediately delete BODs from the CloudSuite Business
Replication Document Outbox after ION processes them. Otherwise, the processed BODs remain
in the outbox for the number of minutes specified in the Outbox Cleaner Expire Time field.

4 Test and save the connection point.

Connection points are not activated separately. When you activate a document flow, the associated
connection points are activated.

Defining BODs for the ERP connection point

In ION Desk, select Model > Connect > Connection Points.
Select an existing CloudSuite Business connection point.
Click the Documents tab.

Click Add and specify all of the documents that can be sent or received by this CloudSuite Business
instance (site).

The inbound and outbound BODs that are required for each CloudSuite Business integration with
another Infor application are listed in "BODs used in integrations with this application" on page 103.

B WODN -

Add the BODS for integrations that you plan to implement. For “outbound” BODs, select Sent from
this application. For “inbound” BODs, select Received in this application.

5 Save your changes.
You can also add custom document types.
See the Infor ION Desk User Guide.

Note: If you later remove a BOD from a connection point, and that BOD is used in a document flow,
an error is reported in the document flow messages pane.

Configuring document flows

You must create document flows in ION Desk in order to pass BODs between applications.

Setting up a document flow to Infor Ming.le to pass user and role
information

Ensure that connection points are set up and a document flow is activated in ION Desk so that BODs
are sent between CloudSuite Business and Infor Ming.le.

1 In ION Desk, verify that an Infor Ming.le connection point exists. You should have already set up
the connection point when you completed the post-installation steps when you installed Infor OS.
See the Infor Operating Service Installation Guide.
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2

3

7
8
9

Ensure that the Infor Ming.le connection point is set up to send and receive these BODs:

Document Receive in application Send from application
Process.SecurityUserMaster | X

Sync.SecurityRoleMaster X

Sync.SecurityUserMaster X

In ION Desk, create a new document flow between the CloudSuite Business connection point and
the Infor Ming.le connection point:

a Select Model > Connect > Document Flows.
b Create a document flow called erp_mingle.xml.

¢ Drag and drop three applications onto the flow and change the names to MINGLE_1, ERP_1,
and MINGLE_2.

- MINGLE _1 ERP_1 MINGLE_2
( F— —_— —

Start End

In the properties pane for each of the application boxes, click Add and add the appropriate connection
points.

Note: You only need to add one CloudSuite Business site as a connection point. The sites are all
in one database, so basic user data is shared between all sites. However, if you want to ensure that
updates to roles (groups) are also shared between all sites, you must set up a master site and
shared user tables in CloudSuite Business. (See the Infor CloudSuite Business Multi-Site Planning
Guide — Cloud Edition.) If you don’t want to use a master site and shared user tables, then you must
include all of the CloudSuite Business site connection points in this document flow.

Click the document icon between MINGLE_1 and ERP and ensure that it lists this document:

+ Sync.SecurityUserMaster

Click the document icon between ERP and MINGLE_2 and ensure that it lists these documents:

» Process.SecurityUserMaster
» Sync.SecurityRoleMaster

Save your changes.
Activate the document flow.
Open CloudSuite Business from the App menu.

10 In the Replication Document Manual Request Utility form, select the Sync SecurityRoleMaster BOD.

Select Initial Load and click Process. This publishes the security roles from CloudSuite Business
, Which are sent to Infor Ming.le. The Infor-SystemAdministrator group fromCloudSuite Business is
synchronized with the Infor-SystemAdministrator role in Infor Ming.le.

For information about these BODs, see "User and role BOD usage" on page 85.
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Configuring other document flows between applications

Usually, document flows are configured and activated in conjunction with integrations between Cloud
Suite Business and another application. In that case, skip this section and follow the steps in the
appropriate integration guide. However, if you want to send BODs to another ION-enabled application
but there is not an appropriate integration guide, you can follow these general steps. See the Infor ION
Desk User Guidefor more information

1 Define a new document flow that includes connection points for both CloudSuite Business and the
other application.

2 Define the documents that flow between the applications, and the direction that they flow.

Save the document flow.

4 Activate the document flow.

w

Configuring the Infor Ming.le message listener

The Infor Ming.le message listener automatically forwards all BODs for specified verbs to Infor Ming.
le. The Infor Ming.le message listener must be configured and activated in order to view drillbacks from
your application in Infor Ming.le.

You should have configured the listener as part of the post-installation steps in the Infor Operating
Service Administration Guide. Ensure that it is activated in ION Desk.

See the Infor ION Desk User Guide for information about message listeners.

Publishing BODs

This section provides a general description of how to publish, or generate, BODs from CloudSuite
Business, and how to verify that data is flowing out of your application into ION.

For the steps to publish BODs for a specific integration, see the appropriate integration guide.

When you publish BODs in CloudSuite Business, they are placed in the Replication Document Outbox,
where ION can retrieve them. The published BODs are then available to any application that subscribes
to the BODs through ION. Products can subscribe to BODs either through a document flow or through
a listener.

Starting products and services

Before publishing BODs from CloudSuite Business, start these products, services and processes if
they are not already running:

Infor CloudSuite Business Configuration Guide for Infor Operating Service | 39



Configuring your application and ION to send and receive BODs

+ CloudSuite Business
« Other products with which you are communicating through Infor ION
* |ON Service

Use the ION Grid Management user interface to verify that the ION Service is running. See the Infor
ION Grid Administration Guide.

Publishing initial data

During normal processing, BODs are automatically generated (published) when a user makes a data
change or completes a transaction. However, when you start a new integration with another application,
you must manually publish BODs that pass the current set of data from your application to another
application, so that the base systems are synchronized. The BODs are placed in the Replication
Document Outbox, from which ION retrieves them and passes them to the other application.

To publish initial ERP master and transaction data into BODs that are placed in the Replication Document

Outbox:

1 In CloudSuite Business, open the Replication Document Manual Request Utility.

2 Select Initial Load so that the data is processed as an insert, that is, as new data.

3 Select the BODs to include in the data load. The BODs you select are different for each integration.
See the appropriate integration guide for the BODs to load.

Note: If you select multiple process BODs at one time, the BODs are processed in alphabetical
order. However, you must load certain BODs in a specific order,to prevent errors in the integration
due to missing data. See "BOD dependencies" on page 40.

4 Click Process to process the selected BODs.

5 Continue to select and process BODs until all of the BODs are processed that are required for a
specific integration.

6 Repeat this process at each CloudSuite Business site.

When you use this utility to publish BOD data, the current date is used for all Status/EffectiveDateTime
elements.

After the initial data load, CloudSuite Business automatically publishes BODs whenever users change
certain data or when certain transactions occur in CloudSuite Business. For a list of the events that
generate BODs, see "Business events that generate outbound BODs" on page 91.

BOD dependencies

Be aware that you must load these BODs in this order to prevent errors in the integration due to missing
data:

* CodeDefinition
e ltemMaster
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Location
CustomerPartyMaster
BillToPartyMaster
ShipToPartyMaster
SalesOrder

Shipment

Invoice

Verifying the ION configuration

Use these tasks to verify that the connections are set up correctly.

Verifying that BODs are published

1

Use the information in "Business events that generate outbound BODs" on page 91 to determine
what user actions generate certain BODs.

Perform those user actions in CloudSuite Business.

For example, information from the Vendors form is replicated through the SyncSupplierPartyMaster
BOD, so you could change the vendor address and save your change.

Check the Replication Document Outbox form in CloudSuite Business to see if a BOD was generated
and marked as processed.

In our example, the SyncSupplierPartyMaster BOD is generated.

Depending on settings, the BODs might be removed immediately from the outbox after ION retrieves
them. In that case, you can check ION Desk OneView to verify whether the BOD was sent and
processed.

In ION Desk, review the messages by using ION Desk OneView or other ION Desk functions.

If messages are not displayed in ION Desk, check the CloudSuite Business Replication Document
Outbox form to see if the BODs were generated but not retrieved by ION.

If messages are not flowing, review the XML data for the BOD.

Verifying that ION receives data

To verify that ION is receiving BODs from CloudSuite Business, monitor these areas in ION Desk:

Select Manage > Connect > Active Connection Points to show the message queue counts.
Select Manage > OneView to show individual messages, if they are enabled.
Select Manage > Error BODs to see if any errors were reported.
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If you encounter problems, see "Data is not flowing properly" on page 89.

Verifying the data flow between applications

After you create and activate document flows to other applications, you can check the message inbox
area of the other applications, to ensure that data is flowing between the systems. See the other
application’s documentation to determine how to find the message inbox.

42 | Infor CloudSuite Business Configuration Guide for Infor Operating Service



Configuring user access to your
application through Infor Ming.le

Users, roles, and person IDs are initially defined in Infor Ming.le and shared with all of the other
applications that run through the Infor Ming.le portal. Roles and some user information can later be
modified in CloudSuite Business.

Users and roles

Because Infor Ming.le is the system of record for users, you must set up users in Infor Ming.le. The
users are then synchronized through BODs to other BOD-enabled applications in the Infor Ming.le
portal. After the users are synchronized to your application, you can continue the user setup in your
application.

You can perform these user management tasks in Infor Ming.le:

+ Create users, including manual import of users
* Update users

* Delete or deactivate users

* Reset passwords

* Monitor recent user activity and mobile sessions
* Manage sessions

How Infor Ming.le users and roles work with ERP users and groups

When you create or update a user in Infor Ming.le, the information associated with that user is used to
automatically set up some user information in CloudSuite Business. This association is handled through
Sync SecurityUserMaster BODs that are passed through ION.

User roles (known as groups in CloudSuite Business) should be updated and maintained in CloudSuite
Business, because the types of roles and the names of roles are dependent on the requirements of

CloudSuite Business. After the roles are set up in CloudSuite Business, they are synchronized to Infor
Ming.le through the Sync SecurityRoleMaster BOD, so that Infor Ming.le is aware of all possible roles.
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The ability of security roles to perform specific operations and access specific data is enforced by Cloud
Suite Business, not Infor Ming.le.

Infor Ming.le provides a default Infor-SystemAdministrator role that allows for full access to all applications
that are linked to Infor Ming.le. CloudSuite Businessl has an Infor-SystemAdministrator group or role
that allows access to all CloudSuite Business screens. When a user who has the
Infor-SystemAdministrator role inInfor Ming.le is synchronized to CloudSuite Business, that user
automatically has access to all CloudSuite Business forms.

Configuring user access to the ERP through Infor
Ming.le

You must add other users in Infor Ming.le before they can access CloudSuite Business through Infor
Ming.le.

1 From the Infor Ming.le User Menu, select User Management.

e Jenny

Alerts
Tasks
Notifications

Posts

Admin Seitings

User Settings

User Management

2 From the menu on the left side, select Security Administration > General Settings.
3 Click SCIM Configuration.

4 Configure these general properties to ensure that new or changed user information is synchronized
with other applications:

Publish Security User Master BOD
Select this option to publish the SecurityUserMaster BOD when a user’s details are changed in
Infor Ming.le. This synchronizes the user details with other applications that subscribe to the BOD.

User Synchronization Interval (min)
If you selected the Publish Security User Master BOD option, specify the interval, in minutes, at
which you want to publish the updated BODs to synchronize users.

5 To set up system administrator access for your account between Infor Ming.le and CloudSuite
Business, add the Infor-SystemAdministrator role to your account:
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®O O O T O

In Infor Ming.le, select User Management from the user menu.
Select your system administrator account and click the Details icon.
Click the Security Roles tab.

Click + and add the Infor-SystemAdministrator role.

Click Add.

6 On the Users page, follow these general steps to add users. See the Infor Ming.le online help for
more information.

Note: If your application already has legacy users set up, you can import the users into Infor Ming.
le from a .CSV formatted file. See the Infor Operating Service Administration Guide. To temporarily
disable user synchronization before the import, clear the Publish Security User Master BOD option
and select Do not enable for the Enable SCIM Parameter configuration option. Then select Allow
Import. The Import option is then enabled on the Manage > Users page.

a
b

Click + to add a user.

Clear the Send Invitation option so that you can send the invitation later, after you have completed
the user setup.

Save your changes.
Click the details icon & to view details for the user.

Note: The IFS Person ID will be used to synchronize personnel records with CloudSuite Business
. It is generated automatically and should not be changed.

In the Security Roles tab, assign the user to one or more roles, and click Add & Close.

You might not see all of the application-specific roles. If you do not see the roles you need, those
roles can be added and assigned later from within CloudSuite Business.

Save your changes.

The information is sent through BODs to CloudSuite Business after you save your changes.

7 Open CloudSuite Business from the App Menu.

=52 Infor Ming le™
H

Infor Ming le™ Infor ION AP

® &

ION Desk ION Decision Document

Service Management

¥

Factory Track Configure Price
CloudSuite: Quote

8 If prompted, select a configuration, which is linked to one of your CloudSuite Business sites. If you
plan to use one site as a master site, select the configuration for the master site.
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| CSI9010A DEM_DALS |

9 In CloudSuite Business, select Form > Open and open the Users form.

10 |n the Users form, click the filter toolbar button B to see all of the users who were defined in Infor
Ming.le.

11 Update the information for each user to specify additional required or optional fields that are not
shared with Infor Ming.le. See the CloudSuite Business online help for more information.

a After you add your users in Infor Ming.le, verify that the user information has been sent through
BODs to CloudSuite Business. This information should be shown in the CloudSuite Business
Users form:

* The user name (email address) that you set for each user in Infor Ming.le is shown in the
User Name field.

* The IFS Person ID that was set for each user in Infor Ming.le is shown in the Workstation
Domain/ID field.

These values should not be changed.

b Assign the user’s form editing permission level, PO requisition limit, and multi-site group
authorization, as needed. See the online help.

¢ Set the user’s password for the CloudSuite Business web client or click once client.

(This is not the same password that is used to log into the Infor Ming.le portal. The Infor Ming.le
portal password uses the IFS ID tied to the Workstation ID, so no additional user login is required
to access the CloudSuite Business application in Infor Ming.le.)

When users access CloudSuite Business through the web client or the click once client rather
than through Infor Ming.le, they must know this password.

d Ensure that the email address that you set for each user in Infor Ming.le is shown in the Primary
Email Address on the Users form. This value should not be changed. We recommend setting
these additional fields for the user:

Groups Additional Info  Login Information  Email Address  Source Control

Primary Email Address: Primary
Use R
Se

Send External Prompts Primary

csummers@csgde.com

Primary csummers@csgde.com

Primary csummers@csgde com

4[4 |44

csummers@csgde.com

Email Type Description Email Type Address

¥ Primary csummers@csgde.com

e Inthe Groups tab, click in the grid and select Actions > New to add a new row.
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Users

w

User Name: | bob white@inforcom

on: | Bob White

Confirm Pz

Workstation Domain/ID: | 7TED4FAD3-CB5C-4BC2-0F9B-DET382ECTADC

Editing Permissions.”| Basic ¥ | User Modules Row Authorizations... User Authoriz

oups Additional Info  Login Information  Email Address  Source Control

. - Primai
: . Stom Besernion

Infor-SuiteUser Sync: automatic

%2 | Accounts Receivable Accounts Receivable Group

f Clickin the Group Name field to view the list of groups. Add any groups to which this user should
belong. If you were able to assign the groups as security roles for the user in Infor Ming.le, you
will see them listed here. Otherwise, you can assign the additional groups here.

g Click User Modules and assign the appropriate license modules to the user.
By default, users who are originally created in Infor Ming.le and sent through BODs to CloudSuite
Business are assigned a Transactional license in CloudSuite Business.
h Save your changes.
12 In Infor Ming.le User Management, select the user’s record, and then select Action > Resend
Invitation.

The user receives a notification with a link that provides user-specific access to Infor Ming.le and
to CloudSuite Business.

Configuring additional system administrator access to
the ERP through Infor Ming.le

1 In Infor Ming.le, add the Infor-SystemAdministrator role to the appropriate users.

After you update the user information, a BOD is sent from Infor Ming.le to CloudSuite Business to
synchronize the system administrator users with this role.

2 Assign additional system administration roles, either in Infor Ming.le or in the CloudSuite Business
Users form, to the appropriate users.

Setting up roles or groups

Predefined security roles (groups) are set up in the CloudSuite Business application and in Infor Ming.
le. You can add groups, and add users to the groups, in CloudSuite Business. These updates are then
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sent to Infor Ming.le through the Sync.SecurityRoleMaster BOD. This BOD is defined at the tenant
level.

1 In CloudSuite Business, use the Groups form to create roles that can access specific forms, programs,
and logical folders.
A BOD is generated by CloudSuite Business. The information from this BOD is used in Infor Ming.
le to automatically create a matching security role.

2 Associate the roles with users. This can be done in either Infor Ming.le or CloudSuite Business:

+ To associate roles with users in Infor Ming.le, select User Management, click the Details icon,
go to the Security Roles tab, and click +. Infor Ming.le generates a BOD and sends it to all
applications that run in the Infor Ming.le portal. CloudSuite Business uses the information from
this BOD to associate the role or group with the CloudSuite Business user record.

+ To associate roles with users in CloudSuite Business, go to the Users form, filter for the user,
and use the grid on the Groups tab to associate the user with the appropriate groups. Cloud
Suite Business generates a BOD which is sent to Infor Ming.le. Infor Ming.le then sends another
BOD to all applications that run in the Infor Ming.le portal, to update the user records in all
applications.

Note: Do not manually create a security role in Infor Ming.le that does not exist in CloudSuite
Business.

If you delete a role in either CloudSuite Business or Infor Ming.le, you must also delete the
corresponding role in the other application.

About accounting entities

Accounting entities are set up through BODs that are sent by your application to Infor Ming.le.

After the accounting entities exist in Infor Ming.le, you can assign users and groups to them. Infor Ming.
le then sends BODs to your application with the information to be synchronized.

The application is the system of record for accounting entities.

About locations

Locations are set up through BODs that are sent by your application to Infor Ming.le.

After the locations exist in Infor Ming.le, you can assign users and groups to them. Infor Ming.le then
sends BODs to your application with the information to be synchronized.

The CloudSuite Business application is the system of record (SOR) for locations.
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Verifying user access

To verify that users were created properly and can access the appropriate forms in CloudSuite Business

1 Log into Infor Ming.le portal as a user. The user must belong to a role that is defined as an
administrator in both Infor Ming.le and CloudSuite Business.

2 From the App Menu, open CloudSuite Business.
3 If prompted, select the appropriate configuration and click OK. The application session is opened.
4 Open the Users form and verify this information for several users:

* User Name matches the Email address in Infor Ming.le.
»  Workstation Domain/ID matches the IFS Person ID in Infor Ming.le.
* Groups that you assigned to this user are set as roles in Infor Ming.le.

5 Sign out of the application and Infor Ming.le. Close the browser.
6 Log into Infor Ming.le and CloudSuite Business as a non-administrative user who has access.

7 Ensure that you can open any forms that the user has authorization to open, and that you cannot
open any forms for which the user is not authorized. as a non-administrative user who has access
to both

Automatic login and selecting configurations

When users first access CloudSuite Business through Infor Ming.le, they see a dialog box. Because
of Single Sign On, the user ID and password are not requested; however, users must select a Cloud
Suite Business configuration. The Use Workstation Logon option on this dialog box is hidden and is
automatically selected for the user.

Subsequent logins depend on how the user signs in and out of the application and Infor Ming.le:
+ If users sign out of the CloudSuite Business application before exiting Infor Ming.le, then the next
time they open the CloudSuite Business application, they must select a configuration.

» If users close the browser without signing out, or exit Infor Ming.le without signing out of CloudSuite
Business, then the next time they open the CloudSuite Business application, the previous
configuration is automatically selected and no dialog box is shown. To switch to a different
configuration, the user can select Form > New Sign In.

Setting up distribution groups

Optionally, you can set up distribution groups in Infor Ming.le for CloudSuite Business users who require
access to ION in order to view or update information or to troubleshoot errors.
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See the Infor Operating Service Administration Guide.

Service accounts

The Infor Ming.le Service Accounts page shows accounts that have been created to allow applications
a resource owner grant to contact the Infor Authorization Service to obtain a token for use in making
API requests.
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Use this information to set up the APIs.

Using ION APIs to consume Mongoose REST services

The ION API service is a broker for Infor applications that use web service APIs. The service handles
synchronous communications to application specific APls, versus asynchronous BOD communications
that conform to the OAGIS standard.

Currently CloudSuite Business does not require any configuration of ION APIs. However, you can
configure any Mongoose-based application running in Infor Ming.le to allow calls to the Mongoose
REST service through ION API.

Settings in the IDO Request Service web.config file determine whether the Mongoose REST service
is enabled for use with ION API or is using the traditional Mongoose token exchange.

For more information about authenticating against ION API to consume Mongoose REST web services,
see the Infor Ming.le ION API User Guide.

For more information on consuming Mongoose REST web services and which methods are available,
see Using Infor Mongoose REST Web Services or use the Open APl documentation that is available
inthisarea: https://mongoose application server/IDORequestService/MGRestService.
svc/api-docs/ where mongoose application_server is your server.
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You can configure workflows and ION messages for your application.

|ION messages

This table shows the types of ION messages:

Type
Alert

Task

Notification

Description

In ION Event Management, you can monitor business events and create
alerts when exceptions occur. BODs are published by applications
when business events occur. Monitors are processes that run in the
Event Management engine and evaluate these BODs by applying pre-
defined business rules: comparison conditions, value change conditions,
and document overdue timer based rules.

When exceptions are detected, these are reported as alerts to the
business users. The distribution list of alerts is included in the monitor
definition. Users can receive alerts on their homepages or by email.

A task is a workflow step that creates an entry in a user's task list. The
workflow stops until the user has completed this task, and then the next
step in the workflow begins.

A notification is a workflow step that creates a notification in the user’s
task list. The workflow continues after the notification is sent to a user.
You can configure notifications to perform these actions:

+ Send a message to inform the user that a certain point in the work-
flow has been reached.
» Optionally, include notes from previous steps.

» Display workflow parameters and structures.

A distribution list can be defined for notifications.
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Type

Alarm

Description

create monitors, called alarms.
In ION Desk, the business administrator can create alarm templates.

After the templates are activated, mobile users can use the templates
to create alarms in the ION Alarms mobile application. The alarm creator
can specify the distribution list for the resulting alert. See the Infor ION

Alarms Mobile Application User Guide.

The ION Alarms mobile application for Android devices is available to

The users receive the alert on their Infor Ming.le page, in the Infor Ming.
le mobile application, or by email.

About alerts sent from the ERP to Infor Ming.le

CloudSuite Business can send PulseAlert BODs to ION that can be displayed as alerts in Infor Ming.

le, as shown in this process flow:

ERP l—+Process Pulsedlert BOD—»

Infor ION

—Sync PulseAlert—is
+API

Infor Ming.le

A Process PulseAlert BOD is generated when a business event associated with one of these publications

occurs in CloudSuite Business:

Publication
CustomerCreditHoldAlert

CustomerlinteractionFollowUpAlert

CustomerOrderCreditHoldAlert

CustomerShipmentAlert

DCShopFloorTransactionErrorAlert

Description

A customer was put on credit
hold

A follow-up is needed to a cus-
tomer interaction. Key Value 1
defines the customer number.

A customer order was put on
credit hold

An order was shipped to a cus-
tomer (for specific orders/cus-
tomers)

A specified number of Data Col-
lection shop floor transaction er-
rors occurred. Key Value 1 de-
fines how any errors must be

Where defined

Event: IdoOnltemUpdate, Seq
15

Event: CustomerinteractionFol-
lowupAlert, Seq 1

Event: IdoOnltemUpdate, Seq
16

Event: IdoOnltemUpdate, Seq
17

Trigger on dcsfc_mstlup
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Publication

JobMaterialCostAlert

JobOperationHoursAlert

JobOverProductionAlert

JobProjectedLateForCustomerAlert

LateOrderShippingAlert

LeadAssignedAlert

LockedUserAlert
OpportunityDueAlert

OverBudgetAlert

ProjectedLateShipAlert

ProspectinteractionFollowUpAlert

ScheduledMaintenanceAddedAlert

Description

generated before the user re-
ceives an alert

The quantity issued against a job
is more than required and the
total material cost (actual) of the
job exceeds the required cost by
a certain percent (tolerance) set
by the user

Labor hours for a job were more
than estimated

The completed quantity of a job
is greater than the released
quantity

A job is projected to be late for a
specified customer. Key Value 1
is the customer number.

At least one open order line for

a customer has a due date prior
to the current date. Key Value 1
is the customer number

Alead is assigned to a salesper-
son

A user is locked out

An opportunity is due

The specified account's actual
amount is above budget for the
current fiscal period. Key Value
1 is the account number, and
Key Value 2 is the percentage
over budget that triggers an alert

An order line is projected to ship
late. Key Value 1 is the customer
number.

A follow-up is needed with a
prospect. Key Value 1 is the
prospect ID.

A scheduled maintenance task
is added for a resource. This
alert is used only with the Mold-
ing Industry Pack.

Where defined

Trigger on jobmatl_mstlup

Trigger on jobroute_mstlup

Trigger on job_mstlup

Trigger on job_sch_mstlup

Event: LateOrderShippingAlert,
Seq 1

Event: IdoOnltemUpdate, Seq
19

Trigger on UserNameslup

Event: OpportunityDueAlert,
Seq 1

Event: OverBudgetAlert, Seq 1

Event: IdoOnltemUpdate, Seq
18

Event: ProspectinteractionFol-
lowUpAlert, Seq 1

Trigger on MO_re-
source_maint_mstlup
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Publication Description Where defined

ScheduledMaintenanceAlert A scheduled maintenance task Event: ResourceMainte-
has been changed from Planned nanceScheduleUpdateStatus,
to Scheduled for a resource. This Seq 1
alert is used only with the Mold-
ing Industry Pack.

TransactionAmountAlert The amount of a transaction for Event: TransactionAmountAlert,
a specified account is over the Seq 1
specified amount. Key Value 1
is the account number. Key Val-
ue 2 is the amount to which
transactions should be limited.

CloudSuite Business users can subscribe to the appropriate publications. Then, when an alert occurs
and a BOD is generated, the email addresses for all subscribers are included in the BOD.

The email address that is used in the BOD is determined by the Email Type Description field on the
Users form. If an address is specified where the Email Type Description is set to PersonlD, then the
email address that is associated with the PersonID type is used. If no PersonlID type is found, then the
address in the Primary Email Address field is used, as shown in this example:

Groups Additional Info  Login Information Email Address  Source Control
Primary Email Address: Primary ¥ | |bob.smith@infor.com
Use Reply To PersoniD ¥ | |bsmith@inforcom
Send External Notifications | Primary w | |bob.smith@inforcom
Send External Prompts Primary w | |bob.smith@inforcom

Email Type Description Email Type Address
1 PersoniD bsmith@inforcom
2 b Primary bob.smith@infor.com

If neither of these areas are populated, then a BOD is not sent.

ION attempts to match the email address from the BOD with a PersonID or primary email address that
is defined for a user in Infor Ming.le, so that it can pass along the alert. If a matching address is found,
and if the user has the appropriate Infor Ming.le permissions, the alert is displayed on the user's Alerts
panel in Infor Ming.le.

This is the general process flow:
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ERP user subscribes
to mobile alerts or
publications

v

Alert occurs.
Application Event
System generates
GenericSendBOD

event in ERP

MNote: WF Event
Handlers must be
activated for some

alerts

¥

ERP generates
ProcessPulseAlert
BOD

v

Infor ION receives
BOD and transforms
it to a Sync
PulseAlert

v

Infor Ming.le listens
for Sync PulseAlert
BODs using web
services

¥

Infor Ming.le
displays alert to user|
in Alerts panel

MNote: Users must
have appropriate
Ming.le permissions
to see alerts and
must be defined in
both ERP and
Ming.le/IFS with
same Personld

Configuring monitors for alerts

1 Configure CloudSuite Business to send alerts.

a
b

In the Process Defaults form, set ION Pulse Interface to 1.

For publications (alerts) that have associated event handler sequences, activate the sequences
so that the BOD will be sent when the events fire. In the Workflow Event Handler Activation form,
select the appropriate event and sequence, and select Active for this Site.

See the list of publications and their associated event handler sequences in "About alerts sent
from the ERP to Infor Ming.le" on page 54.

CloudSuite Business users must subscribe to the appropriate publications (alerts) from the list
above, through either the Mobile Alerts form or the Publication Subscribers form.

Set up CloudSuite Business users with either a PersonID email address or a primary email
address, or both. In the Email Addresses tab on the Users form, add a record to the grid where
Email Type Description is set to PersonID and an email address is assigned. You can optionally
set the Primary Email Address to another email address for the user.

See "Person IDs" on page 85.
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2 Configure ION to process alerts from this application.

Ensure that the Process PulseAlert BOD is included in the list of BODs that can be sent from the
CloudSuite Business connection point.

a In ION Desk, select Model > Connect > Connection Points.

b Select the Infor Ming.le connection point and add Process.PulseAlert in the Documents tab if it
does not exist.

Through an internal API, ION passes the alert to Infor Ming.le as a Sync.PulseAlert BOD. See the
Infor ION Desk User Guide.
3 Configure Infor Ming.le to display alerts for this application.

Set up Infor Ming.le users with the appropriate roles to access tasks and alerts. See information
about configuring user access for tasks and alerts in the Infor ION Desk User Guide.

In addition, the value in the Infor Ming.le/IFS Person ID field must match the Workstation/Domain
ID field for the same user in CloudSuite Business, and theUser Name field in Infor Ming.le must
match either the Personld email address or Primary email address for the same user in CloudSuite
Business. This is handled automatically if you set up users first in Infor Ming.le/IFS and then use
SecurityUserMaster BODs to populate the user records in CloudSuite Business, as described in
"User and role BOD usage" on page 85.

Configuring workflows for tasks and notifications

See the Infor ION Desk User Guide for detailed instructions on some of these steps.

1 Configure this application to send tasks and notifications.
2 Configure ION to process tasks and notifications from this application.
3 Configure Infor Ming.le to display tasks and notifications for this application.

Other workflow options

In addition to the ION workflow features, CloudSuite Business has a built-in event and workflow feature
called the Application Event System (AES). There might be times when you want to use AES instead
of the ION workflow features.

Use AES when you need to handle any of these tasks with no coding:

« Capture what is happening inside the application and take action on it. ION can only capture events
that consist of BODs being transmitted.

« Suspend an update within the application and wait for approval. The resulting workflow can be
routed out to ION and back in the Ul if desired, but ION cannot suspend a transaction.
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+ Perform automated processing, like inserting orders, updating customers, etc. In AES, you can
select any IDO for any of these operations from drop-downs, and update, insert, delete, or query
without having to write code.

Use ION when you are orchestrating interactions between applications via BODs.

You can use the two systems together in a variety of ways as well-AES can send and respond to the
receipt of ION BODs.
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Infor Ming.le users can share screens and business data in some ION-enabled products that are
integrated with CloudSuite Business. The screens and business data can include embedded drillback
links to CloudSuite Business. If a screen or business data is associated with a BOD that was sent from
CloudSuite Business, and the screen or data has an associated drillback link, then users can click the
link to view the screen that has the supporting information for the source transactions.

For example, you might have a Homepage widget in Infor Ming.le that draws its data from the
CustomerPartyMaster BOD in CloudSuite Business. If the user selects the drillback option from that
widget, it opens the Customers form in CloudSuite Business.

A drillback link can be defined for each type of BOD noun, for example, SalesOrder or ltemMaster. The
link is configured to open a specific CloudSuite Business screen for that noun. Not every BOD noun
has an associated drillback view in CloudSuite Business.

Drillbacks are included in the package when you add the CloudSuite Business application to Infor Ming.
le.

Available drillbacks

This table lists the views that are currently available and the CloudSuite Business form that is launched:

BOD Noun Drillback view CloudSuite Business form
BillToPartyMaster BillToPartyView Customers

ContactMaster ContactMasterView CustomerSalesContactCrossReferences
CustomerPartyMaster CustomerView Customers

CustomerReturn CustomerReturnView RMAs

InventoryAdjustment AdjustmentOrderView MaterialTransactions

ltemMaster ltemView ltems

PayFromPartyMaster PayFromPartyView Customers

Person EmployeeView Salespersons
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BOD Noun Drillback view
PurchaseOrder PurchaseOrderView
Quote QuoteView
ReceiveDelivery ReceiptView
RemitToPartyMaster RemitToPartyView
Requisition RequisitionView
SalesOrder SalesOrderView
ShipFromPartyMaster ShipFromPartyView
Shipment ShipmentView
SupplierPartyMaster SupplierView

CloudSuite Business form
PurchaseOrders

Estimates
MaterialTransactions
Vendors
PurchaseOrderRequisitions
CustomerOrders

Vendors
MaterialTransactions

Vendors

Loading the BODs that are used in drillbacks

In order to use these drillbacks, you must perform an initial load of the BODs listed in “Available
drillbacks,” using the Replication Document Manual Request Utility in CloudSuite Business.

See "Publishing initial data" on page 40.

Verifying a drillback

Drillbacks are displayed in the Infor Ming.le user interface as links that open CloudSuite Business to
a specific screen filtered for specific results. For example, an Infor Ming.le search result, alert, or share
can include a link to the form with a reference to specific CloudSuite Business data.

To verify that the drillbacks are working:

1 From the App menu, open CloudSuite Business.

2 Open a form that has a drillback, for example, Customers.

Note: The user interface does not indicate whether a screen has a drillback. In order for a screen
to have a drillback, a drillback must be configured and a business context message must also be
sent. See "Available drillbacks" on page 61 and "Understanding business context messages" on

page 65.

3 Display the information that you want to share, for example, the record for a particular customer.
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Customers.

| Coordinated Bicycles

Main ShipTo Credit Invoicing Banking Contacts Codes

Address [1]; | 57460 Dewitt St

Address [2]: |PO Box 4567

4 Click the Share icon on the Infor Ming.le screen.
5 On the Share overlay, verify that the drillback icon is displayed, add a comment, and click Share.

& Share

;; Connected Users -

#inforaccountingentity:DALS#inforshiptopartymaster: 1:0&inforcustomerpartymaster: 1#inforsalesi
nvoice:1

@n ADD ATTACHMENTS

€ ship to Party:1:0

CANCEL SHARE

6 In the Infor Ming.le feed, find the message that contains the drillback icon, and click the drillback to
verify that it is working.

My Feed
Jenny * Connected Users Today at
l 2:54 PM
#inforaccountingentity: DAL S#inforshiptopartymaster: 1:(#inforcustomerpartymaster: 1#inforsalesinvoi
'§ Like | Show Details | Share | Delete Post
& | Add a comment REPLY
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On the right side of the Infor Ming.le page is a collapsible panel that hosts a series of Infor Ming.le
context and utility applications. These are mini applications that provide information at a glance.

Context apps subscribe to information published by the application frame and display relevant content
only when it is available. The information in the applications is context-sensitive, which means that the
values or content in the app depend on the current context (form or field) that is shown in the Cloud
Suite Business application panel in Infor Ming.le.

Utility apps are lightweight applications that represent information unrelated to content in the application.
They do not communicate with the application frame and, if activated, show only when the application
is open.

Understanding business context messages

A business context message is a JSON message that is sent from a CloudSuite Business screen, field
or other user interface object for the purpose of establishing the current context. These messages can
be used for many contextual purposes within Infor Ming.le, as well as for drillbacks.

Business context messages are used with these context-sensitive apps when a certain CloudSuite
Business form is displayed:

+ Determines the metrics and reports to display in the In-Context Bl context app

+ Determines which critical numbers to display in the Critical Numbers context app

+ Determines which related files from IDM to display in the Related Information context app

For more information about the available in-context metrics and reports,critical numbers, or

context-sensitive IDM documents, see the Infor CloudSuite Business User Guide for Infor Operating
Service.

To find the business context message that is sent by a specific object, use the Context Viewer
application. See the Infor Ming.le online help or user guide.
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Process default settings that allow context messages to be sent

In CloudSuite Business, these options are set on the Process Defaults form:

+ Send Context Message on Form Focus enables sending of business context messages for forms.
Default is 0 (not sent), but it is automatically set to 1 for CloudSuite Business through initialized
data. When set to 1, the context message "screenld": "MGCore_Formname" is sent for all forms,
where Formname is the form name, for example, “screenld”: “MGCore_UsersMaint”.

Note: This process default is set to 1 so that CloudSuite Business context apps work in Infor Ming.
le.

+ Optional Context Message Form Prefix replaces the MGCore default prefix on all forms with a
specified prefix. For CloudSuite Business, the prefix is set to CSI_. So, for example, the Customers
form is sent as CSI_Customers.

Supported business context messages

Business context messages contain sets of contextual information called entities, which include
information similar to that of Infor BODs. CloudSuite Business can pass information about multiple
entities in one business context message. This example shows an inforBusinessContext context
message that was sent from the Customers form:

{"type":"inforBusinessContext","data":{"screenId":"CSI Customers",
"entities": [{"entityType":"InforAccountingEntity","id1":"DALS"}, {"entity
Type":"InforShipToPartyMaster™,"id1":"4851","id2":"0", "accounting
Entity":"DALS","drillbackURL":"?LogicalId=1id://infor.syteline.
dals&page=formonly&form=Customers (FILTER (CustNum$3D%27%20%20%20%20%
2013%27%20AND%$20CustSeqg%3D0) SETVARVALUES (InitialCommand%$3DRefresh))",
"bodReference": {"noun":"BillToPartyMaster", "documentId":"4851",
"accountingEntity":"DALS","logicalId":"1id://infor.syteline.dals"}},
{"entityType":"InforCustomerPartyMaster","id1l":"4851", "name" : "Brand
Central Dept Store","accountingEntity":"DALS"}]}}

The message informs context apps that the Customers form is currently displaying a record for the
Brand Central Dept Store, which has the customer ID 4851 and the Ship To address ID 0, in the
accounting entity DALS. The message contains one or more business entities, or collections of
information, associated with the current record. The entity information can include a relative URL that
can be used to drill back into the application and display the form and record. It also can include a BOD
reference that maps from the current entity in the user interface to a corresponding BOD noun.

Any context apps that are associated with CloudSuite Business receive all of the information in this
message. Each context app searches its data to determine whether it has contextual information to
display that is related to information in this message.

For example, the In-Context Bl (ICBI) context app uses the screen ID of CSI_Customers and the
customer ID 4851 to determine that it should display an Accounts Receivable Aging report for Brand
Central Dept Store. The Related Information context app uses the entity type, or context, and its
parameters from the message to determine if there are any documents related to that context in its
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database. If so, the documents are listed in the app and can be opened. If you drag and drop files into
the Related Information app pane while this form and record are displayed in CloudSuite Business,
the files are automatically linked in Infor Document Management to each of the entity types (contexts)
listed in the context message.

Context and utility apps that work with the ERP

These standard context and utility apps are available for use with CloudSuite Business. For information
about how to use the standard apps, see the Infor Ming.le online help or user guide.

* Alerts

+ Context Viewer

+ Paparazzi

* Posts

+ Tasks

These application-specific context apps are also available:

+ Critical Number context app

Critical numbers are key performance indicators, or KPIs, that are specific to CloudSuite Business
data and transactions. Users must be authorized to view critical numbers, which are associated with
certain CloudSuite Business forms. See "Authorizing users to display critical numbers in widgets or
the Critical Numbers app" on page 68.

* In-context Bl for CloudSuite context app

Use this app to view business critical metrics and reports in an adjacent pane while certain forms
are displayed. For example, when you are viewing a customer record on the Customers form, you
can see metrics specific to that customer.

* Related Information

This app can display context-sensitive files that are stored in Infor Document Management but that
are associated with specific CloudSuite records. You can set up workflows in CloudSuite Business
to handle this. See "Configuring Infor Document Management to work with the ERP" on page 75.

For information about how to use the application-specific apps, see the Infor CloudSuite Business User
Guide for Infor Operating Service.

All of the apps are initially disabled. When the apps are enabled for CloudSuite Business, their content
is displayed in small app panes to the right of your application.
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Critical Number
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Enabling a context or utility app for the ERP

To enable one or more of the context or utility apps to work with CloudSuite Business:

1

2
3
4

5
6

From the User Menu, select Admin Settings.
In the Manage Applications tab, double-click to select your application.
In the Manage Context/Utility Apps tab, select the app that you want to enable.

in the Permissions tab for that app, either select Grant access to all users or click Add new users
and/or IFS security roles to specify certain users or roles in CloudSuite Business that can access
this context app.

In the Applications tab for that app, select your application and enable it for the app.
Save your changes.

In order to see the changes, you might need to sign out of the application and Infor Ming.le. Close your
browser and reopen it.

Authorizing users to display critical numbers in widgets or the Critical
Numbers app

To enable users to view and select critical numbers for display in widgets, home pages or the Critical
Numbers context app, you must set up the appropriate authorizations in CloudSuite Business.

1

Enable the Critical Numbers context app as described in "Enabling a context or utility app for the
ERP" on page 68

In CloudSuite Business, open the Critical Number Users form.
Select a user record.
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On the Categories tab, specify user authorizations for a critical number category, or on the
Permissions tab, specify user authorizations for specific critical numbers.

Save your changes.
Ask the user to log out of CloudSuite Business and then log in again, so the changes can take effect.

Verify that users can view critical numbers that they are authorized to view in the Critical Numbers
context app.

How critical numbers are displayed in the Critical Numbers app

When the user opens a CloudSuite Business form in the Infor Ming.le portal, the form sends a JSON
inforBusinessContext message that includes its entity type. The entity type is the BOD sent when the
content of the form is update. For example, the Customers form has the entity type
InforCustomerPartyMaster.

These actions are taken when the business context message is received:

Check the entity type in the business context message and find the related category of forms.

Determine which critical numbers (if any) the user has selected within that category on the User
Critical Number Selection form.

Determine how many instances of the Critical Number app the user has created in Infor OS.

Load the selected critical numbers into multiple instances of the Display Critical Number form. Each
instance is displayed in a Critical Number pane.

The sequence of the critical number determines which critical numbers are shown. For example, if the
user selected five critical numbers for a category, but only added three instances of the Critical Number
app, then only the first three (sequential) critical numbers are displayed.
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Homepages are a flexible and configurable way to present information and activities to users.
Administrators can build pages for various groups of users, roles, departments, or business functions.
You can select from the library of available Infor widgets or build your own.

The predefined Homepages and widgets for CloudSuite Business were imported automatically when
the application was added to Infor Ming.le.

In this section, you will verify that they are working for your users.
For general Homepages administration tasks, see the Infor Operating Service Administration Guide.

For information about using the homepages and widgets, see the Infor CloudSuite Business User Guide
for Infor Operating Service.

Verifying the homepage and widget content

1 Log into Infor Ming.le as a non-administrative user who has access to both Infor Ming.le and Cloud
Suite Business.

2 Open the Homepages application.
3 Add a Homepage:
a Click Create New Page.
b Specify a title and description for the page and click Create.
¢ Click the ellipsis (...) button and select Page Catalog.
d Select one of the predefined Homepages and click Add Page.
You must be authorized in CloudSuite Business to open that “home page” form.

Page Catalog

B Categorie ~ New & Updated

+ +
Refine by Controlier Home Project Manager Home
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These are the groups/roles associated with each home page:

Homepage name Security role/group
Buyer Home Purchasing
Controller Home Mobile Controller
Customer Service Home Order Entry
Executive Home Mobile Executive
Inventory Control Home Inventory
Production Planner Home Shop Floor Control
Project Manager Home Projects
Salesperson Home Order Entry

e Close the catalog to view your new Homepage.

4 Add a widget:
a Click the ellipsis (...) button and select Widget Catalog.
Select Categories > Application.
In the Refine By filter, select Infor CloudSuite. You should see the CloudSuite Industrial widget.
Click + (Add Widget).
Close the catalog to view your new widget.

- ®0 O O T

Configure the widget.

5 Add a critical numbers widget, and configure it. Ensure that you can view critical numbers that you
are authorized to view in this widget.

You must be authorized in CloudSuite Business to view the critical numbers.

6 Drill down to CloudSuite Business forms from the appropriate widgets.

Modifying permissions for standard pages

The CloudSuite Business Home pages are included in the Standard Pages tab.

If you want only a specific group of users to access the standard page, you can restrict the standard
page to a security role in Infor Ming.le.

To view or change the permissions that are assigned to a page:

1 Open the Homepages application.

2 Click the ellipses (...) button and select Advanced > Administration.
3 On the Standard Pages tab, select the home page you want to edit.
4 Select Actions > Edit Permissions.
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Note: Permissions can be set at the group, role or user level.
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to work with the ERP

Infor Document Management (IDM) and CloudSuite Business are integrated through these methods:

* |ON API (REST-enabled)
+ Context Business Messages

CloudSuite Business delivers application-specific document models for use with IDM.

About the IDM integration

Some reports and documents that are generated in CloudSuite Business can be automatically sent to
Infor Document Management (IDM) for storage. You can then view the documents in IDM or in the
context of a CloudSuite Business form, through the Related Information context app. You can search
the IDM repository for documents by filename, originating user, and date. You can also search for some
documents using other meaningful attributes such as purchase order number or invoice number, if
those attributes are set up for the document type in IDM.

This integration uses CloudSuite Business document workflows, APIs that transmit the data from Cloud
Suite Business to IDM, and a business context model, document types, and an access control list that
are imported into IDM.

Initially, only CloudSuite Business invoice and purchase order reports have predefined document
workflows. You can customize the integration to include additional document workflows, or to modify
the existing workflows.

These attribute values are assigned as metadata that accompanies the documents, and can be used
for filtering within IDM:

» For aninvoice, the metadata includes the invoice number, the number of the customer being invoiced,
and the number of the customer order associated with the invoice.

* For a purchase order, the metadata includes the PO number and the number of the vendor to whom
the PO is assigned.

The API integration has this high-level flow:
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5 BG task name
active onIDM
Document Workflows
form?

Generate reportin
ERP

» BG task complete
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¥

Save reportin IDM
and attach context-
sensitive metadata

Did API call

Yes: APl call —retumn PID, ID, Version
succeed?

No

4

Send “not
successful” email to
report originator
with TaskMan
output

In the case of failure, a notification is sent to the email address that is assigned on the CloudSuite
Business Users form to the user who originated the report. The PDF file that could not be stored in
IDM is included as an attachment in the email.

Setting up the IDM connection in the ERP

In CloudSuite Business, set up the IDM integration:

1 If you are using CloudSuite Business 9.01.00, download and install APARs 224151 and and 228437,
in that order, from Infor Xtreme.

2 Use the External App Parameters form to set up the connection to IDM.
You must use this form at each site to set up a connection to the IDM application. Multiple sites can
connect to the same instance of IDM. Specify this information:

Note: If Infor OS is in the Cloud, your Infor representative can provide the URL and connection
information.

Name
Specify IDM.

Instance
If you are defining more than one instance of IDM, describe the difference.

Active
Ensure that this field is selected for the instance of IDM that you want to use.

URL
Specify the URL of the IDM application.
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Authorization Method

If you select OAuth1, the API call functions as a back-end service, facilitating the impersonation
of the user who is actually creating the documents. In this case, specify the consumer key as the
User Name and the secret key as the Password.

If you select Basic, IFS user authentication is used. In this case, specify a domain name and
password.

CloudSuite Business users are matched to IDM users through the Infor Ming.le (IFS) GUID value,
which is shown in the Workstation/Domain ID field of the Users form.

See the online help for assistance with the fields on this form.

3 Click Verify. If a green check mark is displayed beside the button, the connection is working. If a
red X is displayed, the connection is not working.

Importing IDM definitions for the ERP

1 Log into Infor Xtreme and select Download > Products .

2 From the Product List, select Infor > Enterprise Resource Planning > Infor CloudSuite Business
& Industrial (SyteLine) > Infor CloudSuite Industrial.

3 Download the IDM Configuration.xml file to a local folder from the CloudSuite Business
Download Center on Infor Xtreme.

This file contains document type definitions, Access Control List (ACL) security definitions, and a
business context model (BCM) that is used to link context-sensitive documents stored in IDM to the
appropriate forms in CloudSuite Business.

4 In Infor Ming.le, open the Document Management application and click the Administration menu.

5 Click the Configuration Importer and Exporter icon.

= Documents

6 Click the Import tab.
7 Click Select XML File and browse to the IDM Configuration file from step 3.
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Depending on the version of IDM, you might see a message that shows the impact of the import
configuration file.

8 Click Import XML File.
These objects are imported:

» The predefined document types CS_Saleslnvoice, CS_Servicelnvoice, CS_PurchaseOrder, and
CS_Supplierinvoice.

* A predefined Business Context Model (BCM) for each document type. The BCM is used to map
the document type to the entity type. It also maps the web container ID variables that are sent
in JSON messages from the CloudSuite Business forms. For example, for the CS_SalesOrder
document type, the CustNum value is always stored in {id1}, even if the form's JSON message
sent CustNum as the second or third variable. See the information about business context models
in the Infor Operating Service Administration Guide.

* An Access Control List (ACL) that defines the IFS security roles that can access each document
type.

9 To confirm that the import was successful, click Document Type and look for items with a “CS_”
prefix.

f

New Document Type

CS_PurchaseOrder

(m]

CS_Saleslnvoice

CS_Servicelnvoice

0

CS Suppliednvoice

Document

(m]

File

Document types and their assigned attributes

This table shows the predefined CloudSuite Business document types in IDM, the entity name associated
with the document type, and the attributes that can be used to search and filter within each document

type.

Because a service invoice is a type of sales invoice, it uses the InforSalesInvoice entity name. However,
the context is slightly different: service invoices have the SRO number attribute, while sales invoices
have the customer order number attribute.

If you add attributes to a document type, be aware that the attribute ID in IDM must exactly match the
IDO property name that is sent from CloudSuite Business. This is true for CS_PurchaseOrder,
CS_SaleslInvoice, and CS_Servicelnvoice. However, for CS_Supplierlnvoice, the attribute ID and IDO
property name need not match. If the optional attributes are included for a supplier invoice, CloudSuite
Business can use them.
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Document type Entity name Additional attribute IDs *
CS_PurchaseOrder InforPurchaseOrder PoNum, VendNum
CS_Saleslnvoice InforSaleslInvoice InvNum, CustNum, CoNum
CS_Servicelnvoice InforSalesInvoice CustNum, SroNum
CS_Supplierlnvoice InforSaleslInvoice PoNumber, VendorNumber, In

voiceNumber (Optional: Invoice
Date, VendorOrder, Freight, Misc
Charges)

* These attributes are common to all document types, so are not listed in the table: Description,
AccountingEntity, BOD Reference Accounting Entity, BOD Reference Document ID, BOD Reference
Noun, BOD Reference Revision ID, EntityType, and Location.

Document types and their assigned roles

This table shows the predefined CloudSuite Business document types, the ACL that is used with each
document type, and the IFS roles that are assigned to each document type. The IFS roles are
synchronized with CloudSuite Business and IDM through BODs. See "User and role BOD usage" on
page 85.

If you are not using the standard CloudSuite Business groups, you will need to modify this list in IDM.

Access to read, update or delete the documents in IDM is only allowed for users who belong to at least
one of these roles (groups). You can modify the ACL list in IDM.

Document type ACL name Security roles Permissions

CS_PurchaseOrder InforPurchaseOrder Accounts Payable, Pur- | Read, Update, Create,
chase Regs, Purchas- | Checkln, CheckOut
ing, Purchasing Costs

CS_Saleslinvoice InforSalesInvoice Accounts Receivable, |Read, Update, Create,
Field Service, Order En- | Checkln, CheckOut
try, Order Entry Invoic-
ing Reprint, Projects,

Service

CS_Servicelnvoice InforSaleslnvoice Accounts Receivable, |Read, Update, Create,
Field Service, Service | Checkln, CheckOut

CS_Supplierlnvoice SyteLineVoucher Accounts Payable Read, Update, Create,
ChecklIn, CheckOut
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Disabling the Document Type filter

To ensure that all of the document types will be visible in IDM and the Related Information app:

1 In the Infor Document Management application, click the Administration menu.
2 Click Configuration.

=

Configuration

3 Select Document Type Filter and disable the filter.

::::::::

Document Type Filter

4 Save your changes.

Activating the IDM workflows in the ERP

When CloudSuite Business users generate a document that has an active workflow, the document is
sent to IDM. To activate the workflows:
1 In CloudSuite Business, open the IDM Document Workflows form.

2 Select Active for each predefined workflow if you want that type of document to be sent to IDM.
Your choices should be based on business decisions for the company.

=— Explorer Form ~ Actions ¥ Edit » View ~ Window ~ Help *

= B @ W Cc = B A= a /s 7

IDM Document Workflows

‘ Active ‘ peschnoes Task NamE|ChangeOrderLaser
1 ARInvoiceCreditDebithem. .. SUBSTITUTE("{0}_{1' Active Advanced
2 ARInvoiceCreditDebitMem... SUBSTITUTE("{0}_{1.
3 ARInvoiceCreditDebitMem SUBSTITUTE("{0}_{1.
4 »| ChangeOrderlLaser SUBSTITUTE("{0}_{1.
5 ConsolidatedInvoicingDraft SUBSTITUTE("{0} {1
6 ConsolidatedInvoicinglLaser SUBSTITUTE("{0}_{1'

3 Save your changes.

Later, you could use the advanced features on this form, along with the Application Event System, to
customize the integration. See the online help for assistance with the advanced fields.
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Enabling the Related Information context app for your
application

When you set up the Related Information context app in Infor Ming.le, use the Applications tab to add
the CloudSuite Business application and set it to Enabled.

Verifying the configuration for workflows

After the configuration is set up in all applications, use these steps to generate a document in Cloud
Suite Business and verify that the document is available, with the appropriate attributes, in IDM.

Currently the invoice and purchase order reports are predefined for this process, but we will just verify
the PO report.

1
2

6

In CloudSuite Business, open the Purchase Order Report form and print a purchase order.
Open the IDM Workflow Logs form and verify that a record exists for the new PO.
See the online help for an explanation of the fields on this form.

In the Infor Document Management application, verify that you can find and preview the document
using these options:

Document Type
Specify CS_PurchaseOrder.

Select Attribute
Verify that these attributes are in the list: PO Number and Vendor Number. Select PO Number.

Operation
Select Like.

Value
Specify the PO number. Use the % wildcard character to allow for leading and trailing spaces.

In CloudSuite Business, open the Vendors form.

Select the vendor associated with the purchase order number that you printed.

In the Related Information context app, the document should be displayed automatically. The default
entity type is All, which displays any document that matches the current record.

Verify that you can preview the purchase order.

Troubleshooting:

If a document cannot be inserted into IDM, an error message is sent to the user who generated the
document in CloudSuite Business. The user can then attempt to manually attach the document into
IDM, using the appropriate document type and attributes. However, if the error occurred because
the user does not have the appropriate role assigned in IDM, then the user cannot insert the document
into IDM. In that case, you must ensure that the ACL in IDM has the appropriate roles assigned to
the document type, and that the user is a member of one of those roles in CloudSuite Business and
Infor Ming.le (IFS).
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» If a user prints a range of purchase orders or invoices, the documents will be generated either in
one PDF or in individual PDFs, depending on how the user's Document Profile is set up in Cloud
Suite Business. If all of the documents are in a single PDF, the PDF is attached in IDM to the first
record in the range. We recommend that users set their Document Profiles to generate individual
PDFs for a range of documents.
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Configuring Bl and Analytics content for
the ERP

To configure Bl and Analytics content for the ERP, you must complete these tasks:

» Configure access to Bl.

» Configure In-Context Bl content.

» Configure Bl Dashboards.

» Configure Bl widgets and homepages.
+ Configure Bl reports.

See the Infor Bl documentation for information about performing the steps in the last three bullets.

Configuring access to Bl

In order to use Analytics features such as In-Context Bl or Analytics widgets and homepages in Infor
Ming.le, you must set up roles and permissions in both Infor Ming.le and Analytics.

Setting up roles and permissions in Analytics

See the Infor Operating Service Administration Guide, the Infor Bl documentation, and the Infor Cloud
Suite Business Analytics Installation and Configuration Guide.

Setting up roles and permissions for Analytics products in Infor Ming.le

See the Infor Ming.le online help or user guide for information about how to set up roles and associate
them with an application.
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Configuring In-Context Bl content

You can display CloudSuite Business In-Context Bl metrics and reports in Infor Ming.le. To display the
metrics and reports with the appropriate forms:

1 Install the CloudSuite Business Bl Content, as described in the Infor CloudSuite Business Analytics
Installation and Configuration Guide.

2 In Bl Dashboards, set the content connection to point to the web server that runs Application Studio
WebServices. The content connection must point to the report catalog that contains the In-Context
Bl reports.

3 Enable the In-Context Bl for CloudSuite Business context app and set up authorizations for it.
See "Enabling a context or utility app for the ERP" on page 68.
4 In Analytics, add all CloudSuite Business users, as defined in Infor Ming.le (IFS), to the ReportViewer
group:
a From Infor Ming.le, open the Bl Application Manager.
b Click Dashboards and select User and Permission Management > User and User Groups.

Annlicat Duandow und st snd sonfiours. sonlostione

Dashboards

Y  Users and User Groups o

¢ If the In-Context Bl context app has been enabled, it is listed in the Application field. Select
In-Context Bl and select ViewRole.

Users and User Groups Basic Groups Application Roles

B. ) B ’ B

Infor Federation Services CE

cation: | BI Application Manager -]

In-Context Bl

Infor-SystemAdministrator E Every S50 User : AdministratorRole

Infor. SylelineSaaSAdmin@infor.com E Report Designer i DesignerRole

Jesse.overly@infor.com E 8 Report Viewer E MasterRole

zachary.makris@infor.com E T ViewRole E &

Hope it can clarify your questions

d Click the editicon on the left to select the users or user groups who should have view permissions
for In-Context BI.

For information about using In-Context Bl content for your application within Infor Ming.le, see the Infor
CloudSuite Business User Guide for Infor Operating Service.

Note: In order to show the In-Context Bl reports with your application screens, the Bl Dashboards
server must be running.
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User and role BOD usage

This appendix provides detailed information about how the security BODs are used between Cloud
Suite Business and Infor Ming.le.

BODs that send roles (authorization groups) from the
ERP to Infor Ming.le

Some roles from CloudSuite Business are preconfigured in Infor Ming.le when the application is added
in Infor Ming.le.

When you create or edit an authorization group in CloudSuite Business, a Sync.SecurityRoleMaster
BOD is generated. This BOD is defined at the tenant level. The information from this BOD is used in
Infor Ming.le to automatically create a matching security role.

If you create a security role in Infor Ming.le that does not exist in CloudSuite Business, you must
manually create a matching group in CloudSuite Business. Remember that CloudSuite Business is the
system of record for roles/groups.

If you delete a role in either CloudSuite Business or Infor Ming.le, you must also delete the group or
role in the other application.

Person IDs

Any CloudSuite Business users who plan to use Infor Ming.le or other Infor OS components must be
set up as users in Infor Ming.le, and the user’s Person ID must be synchronized between Infor Ming.
le and CloudSuite Business.
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Person IDs in Infor Ming.le

The user details page in Infor Ming.le includes an ERP Person ID tab. The ERP Person ID tab is
populated if CloudSuite Business publishes the Sync Person BOD. The ERP Person ID is used as the
identifier of the user in the ERP application, and allows you to link the Infor Ming.le user to the ERP
application user. The ERP Person ID tab shows all ERP person IDs that are associated with this Infor
Ming.le user.

The IFS Person ID is used as the user identifier in ION, which then links the Infor Ming.le user with the
ION BODs. By default, the IFS Person ID is set to the User Principal Name (UPN) of the user. UPN is
an AD FS concept.

The IFS Globally Unique Identifier (GUID) is the same as the UPN.

Sending the Person ID from the ERP to Infor Ming.le

When certain information is manually added or updated in CloudSuite Business for a user, a
Process.SecurityUserMaster BOD is published by CloudSuite Business.

The Workstation/Domain ID field on the Users form in CloudSuite Business contains the Person ID
for a user. This value should not be changed. It is possible to update this value in CloudSuite Business
and then manually publish the Process.SecurityUserMaster BOD to Infor Ming.le; however, Infor Ming.
le is the system of record for user information, so you should only maintain the Person ID value In Infor
Ming.le.

BODs that send user information from Infor Ming.le to
the ERP

When you add a user in the Infor Ming.le portal, a SecurityUserMaster BOD is sent through ION to
your application at the specified intervals, where a matching user record is created or updated. This
BOD contains the user name, login, creation date, status, description, email address, and the roles, or
groups, to which the user is assigned.

When CloudSuite Business receives the BOD, these actions occur:
« For a new user that does not exist in CloudSuite Business:

*« A new user record is added.

+ The Workstation Domain/ID field is populated with a row pointer value that should not be
changed.

* The group authorizations for that user are added.
« A primary email type description is added that contains the user’s email address.

* The user’s First Name and Last Name values from Infor Ming.le are combined into the Cloud
Suite Business User Description field, separated by a space.
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For an existing user in CloudSuite Business, if the existing user ID has not changed:

* The existing user group authorizations are deleted.

* The user status, user descriptions, primary email address, and user group authorizations are
updated.

For an existing user in CloudSuite Business, if the existing user ID has changed:
« The record for the user with the matching Workstation Login is set to a status of disabled, and
the Workstation Login for the user is cleared.

+ The Workstation Domain/ID field is populated with a row pointer value that should not be
changed.

* Anew userrecord is created, copying the user information from the disabled record. Any existing
user group authorizations in CloudSuite Business are deleted, and then the groups from the BOD
are added. The status, email, and description are updated if they have changed.

* An Acknowledge SecurityUserMaster BOD is sent back to Infor Ming.le.

BODs that send user information from the ERP to Infor
Ming.le

When any of this information is manually added or updated in CloudSuite Business for a user, a
Process.SecurityUserMaster BOD is published by CloudSuite Business:

User login status

User description: A value is required in this field if you are passing user information from CloudSuite
Business to Infor Ming.le through the Process SecurityUserMaster BOD. The field must contain
values separated by a space. The first value becomes the First Name in Infor Ming.le. Everything
after the space becomes the Last Name in Infor Ming.le. For example, if the CloudSuite Business
User Description is Tom Van Winkle, Tom is the First Name and Van Winkle is the Last Name in
Infor Ming.le.

Workstation login

Primary email address: A value is required in this field if you are passing user information from Cloud
Suite Business to Infor Ming.le through the Process SecurityUserMaster BOD.

Group authorizations

However, if the user information was changed in CloudSuite Business because of an incoming
Sync.SecurityUserMaster BOD from Infor Ming.le, the Process.SecurityUserMaster BOD is not published.

CloudSuite Portals users

If a new user is created in CloudSuite Business based on a request from the CloudSuite vendor or
customer portals, the BOD is not sent to Infor Ming.le.
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Troubleshooting

This section describes actions that you can perform to solve Infor OS integration issues.

Data is not flowing properly
Cause: A problem is preventing the flow of BOD data to ION.

Solution: After you complete the configuration setup, if BOD data is not flowing to ION, use ION OneView
to identify the problem.

ION OneView can be found under the Manage menu in ION Desk. You can perform these actions in
ION OneView:

« Track business documents from a single consolidated view; search for documents using different
search criteria.

» View all ION components that were triggered by the incoming document: Connection Points; document
flow filters and content-based routing; mappings; ION engines for example, Monitor, Workflow, and
Pulse; monitors; activation policies and workflows.

» View more details about these ION components:

Detailed properties for each ION component
List of events that were logged by each ION component while processing the message

Drilldown views that are used to display the appropriate management pages for the selected
ION component

Visibility and correlation of the different messages sent or generated:

Original BOD messages that triggered the whole list of components displayed; Confirm BOD
messages that were generated due to any error while processing the Original BOD message.
Mapped/Updated BOD messages that were created during the processing of the Original BOD
message

View content of BOD messages. This information is only available to authorized users, based
on the roles and permissions that are configured.

For more information, see the section on ION OneView in the Infor ION Desk User Guide.
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To avoid business discrepancies between this application and integrated applications, correct any
errors as soon possible.

BOD information needs to be purged

Information from every inbound BOD, including sequencing information, is collected in a table in the
CloudSuite Business application. This data constantly builds up and, over time, could cause performance
issues. For this reason, system administrators should periodically use the Purge BOD Information form
to purge information from that table. You can set up a background task to perform this function
automatically

You can also use the Replication Document Inbox/Outbox Purge Utility to clear out older BODs from
the Replication Document Inbox and Replication Document Outbox.

ERP help is not working

Verify that the user’s web browser has popup blockers turned off. Clear the browser cache, restart Infor
Ming.le and try again.
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Business events that generate outbound C
BODs

This table shows the events, which are user actions in CloudSuite Business that generate an outbound
BOD from CloudSuite Business:

Verb Noun User action to generate the BOD

Process AccountingBookDefinition Run the Replication Document Manual Request
Utility with AccountingBookDefinition selected.
This should be done once per site.

Sync AccountingChart Run the Replication Document Manual Request
Utility with AccountingChart selected. This should
be done once per site, after the Chart of Accounts
is set up at the site.

Sync AccountingEntity Run the Replication Document Manual Request
Utility with AccountingEntity selected. This should
be done once per site, after the tenant ID is set
up at the site.

Process AdvanceShipNotice Ship the order, either manually with the Transfer
Order Ship form, or automatically in response to
a received Sync Shipment BOD.

Acknowledge BillofMaterials Acknowledge the receipt of a BillofMaterials from
an external application.

Sync BillofMaterials Indicate that changes have been made in the ap-
plication after receipt of a Process BillofMaterials
from an external application

Acknowledge BillToPartyMaster Acknowledge the receipt of a BillToPartyMaster
from an external application.

Sync BillToPartyMaster Change any information on the Customers form.
Change any information on the Ship Tos form.
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Verb Noun User action to generate the BOD
Sync Calendar Add or update a shift calendar in Scheduling
Shifts.

Add a holiday. This creates a BOD that indicates
all resources are busy on that day.

Sync CarrierRoute Select the Physically Shipped check box on the
Special tab of the Delivery Orders form.

Sync ChartOfAccounts Create or update an account record in the Chart
of Accounts form. Statistical and allocation ac-
counts are not included.

Acknowledge CodeDefinition Acknowledge the receipt of a CodeDefinition from
an external application
Sync CodeDefinition * Add an Education Major
* Add an External Expense Type
* Add an Indirect Labor Code
* Add an Inventory Adjustment Reason Code

* Add or update an ISO U/M on the Unit of Mea-
sure Codes form

* Add an ltem Category

* Add an Obsolete Slow Moving Reason Code
* Add an Opportunity Source

* Add an Opportunity Stage

* Add a Payment Type

* Add a Position

* Add a Price Code

* Add a Product Code

* Add a Project Cost Code

* Add a Province/State

* Add a Shift ID on the Scheduling Shifts form
* Add a Ship Via Code

* Add a Skill

* Add a Tax Code of type Exempt

* Add a Tax Jurisdiction

* Add a Territory

* Add a Training Course

* Add a unit code on the Unit Code 1 - 4 forms
* Add a Work Code

* Add a Work Experience
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Verb

Process

Acknowledge

Sync

Sync

Sync

Sync

Acknowledge

Sync

Sync

Sync

Acknowledge

Sync

Sync

Noun

ConstrainedResource

ContactMaster

ContactMaster

Contract

CreditTransfer

CurrencyExchangeRateMaster

CustomerPartyMaster

CustomerPartyMaster

CustomerReturn

DebitTransfer

ExpenseReport

FinancialCalendar

InventoryAdjustment

User action to generate the BOD

BODS for some other codes, such as language
IDs and cost methods, are automatically generated
when the Replication Document Manual Request
Utility is run.

Insert or modify a Shift ID (creates a BOD for as-
sociated resources)

Acknowledge the receipt of a ContactMaster from
an external application

* Add or change a Contact

* Create a Customer Sales Contact Cross-Refer-
ence

* Add or update Customer Order header

* Add or update Customer Order Blanket Line
Create a Bank Reconciliations record for a vendor

payment, employee payment, or customer pay-
ment

Add or update a Currency Rate

Acknowledge the receipt of a CustomerPartyMas-
ter from an external application

* Change any information on the Customers form,
Ship Tos form, or Customer Sales Contact Cross
References form

* Add a prospect on the Prospects form to send
this BOD with a status of “Pending”

* Print the RMA Order Verification Report

* Change the status of an RMA

Post a direct debit transaction from a customer on
the A/R Direct Debit Posting form.

Acknowledge the receipt of an expense report.

* Change any information on the Accounting Peri-
ods form

* Run the change Reports To Entity utility

* Perform Quantity Adjustment

* Perform Miscellaneous Receipt or Miscellaneous
Issue

* Perform Cycle Count Posting - one BOD is gen-
erated for each combination of item, warehouse,
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Verb

Sync

Sync

Acknowledge

Sync

Sync

Sync

Sync

Noun

InventoryCount

Invoice

ItemMaster

ItemMaster

LCLTradeStatistics

Location

Opportunity

User action to generate the BOD

and location where the quantity on hand has
changed

* Perform Physical Inventory Posting - one BOD
is generated for each combination of item, ware-
house, and location where the quantity on hand

has changed

* Run the Cycle Count Posting utility
* Run the Physical Inventory Posting utility

One InventoryCount BOD is sent for each
item/warehouse combination

* Print and post an invoice through the Consolidat-
ed Invoicing form

* Post an invoice through the Invoice Posting (A/R)
form

Note: The Invoice BOD publishes one line for ev-
ery order line included in the Invoice. When Line
Summarization is turned on in Consolidated Invoic-
ing, the summary invoice lines are not published;
instead, each customer order line will be published
as a line in the Invoice BOD.

Acknowledge the receipt of a Process ltemMaster
from an external application.

* Create a new item on the Items form

* Make a change to these fields on the Items form:
Item, Description, ABC Code, Commodity, Cost
Method, Material Status, Reason, Backflush, Last
Change, U/M, Unit Cost, S/N Track, Lot Track,
Source, Order Minimum, Order Maximum, Alter-
nate Iltem

* Add or change an item description on the Multi-
Lingual Items form

* Print EU Sales List Report

* Print SSD Transaction Listing Report

* Create a new Warehouse
* Update General Parameters form (creates a
Location BOD with the site as the location)

* Create or update a record on the Opportunities,
Customer Orders, or Opportunity Tasks form
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Verb
Sync

Sync

Acknowledge

Sync

Sync

Sync

Acknowledge

Acknowledge

Sync

Noun

PayableTracker

PayableTransaction

PayFromPartyMaster

PayFromPartyMaster

Person

Personnel

PlanningSchedule

ProductionOrder

ProductionOrder

User action to generate the BOD

* Post a voucher or an Adjustment through the
A/P Voucher Posting form

* Post a payment from any of these forms: A/P
Check Printing/Posting, A/P Draft Printing/Posting,
A/P EFT Posting, A/P Wire Posting

* Post a voucher through the A/P Voucher Posting
form

* Post a payment from any of these forms: A/P
Check Printing/Posting, A/P Draft Printing/Posting,
A/P EFT Posting, A/P Wire Posting

* Set or release a Hold status on a voucher

Acknowledge the receipt of a PayFromPartyMaster
from an external application

* Change any information on the Customers form
* Change any information on the Ship Tos form

* Add or update information about a salesperson
or sales manager on the Salespersons form

* Update information related to a salesperson on
the Employees form (for employee sales people)
or Vendors form (for outside sales people)

* Add or update information on these forms: Em-
ployee, Employee Skills, Employee Cert/License,
Employee Education, Employee Training Courses,
Employee Work Experience, or Employee Position

Acknowledge the receipt of a Planning Schedule
from an external application.

Acknowledge the receipt of a ProductionOrder
from an external application

* Applied filters on the Background Task generate
this BOD for a firm job that is scheduled for the
first time. This does not apply to jobs that have
just been processed by the TriggerProduc-
tionOrderBGSyncSp Background task. You can
add subsequent filters to reduce the number of
BODs triggered by this task. Without filtering, after
every scheduling or planning function a significant
number of BODs could be created.

* Change the status of a job or production sched-
ule.

* Change the Qty Released of a job or production
schedule when the status is Released.
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Verb Noun

Sync ProjectMaster

Process PulseAlert

Sync PurchaseOrder
Acknowledge  Quote

Sync Quote

Sync ReceivableTracker
Sync ReceivableTransaction

User action to generate the BOD

Notes: Creating a job generates this BOD, but
changes to a firm job do not generate this BOD.
This BOD must be included in an initial load of
ProductionOrder data.

Create a Project or change the project status.

One or more of these publications is triggered by
a system event: CustomerCreditHoldAlert; Cus-
tomerlinteractionFollowupAlert CustomerOrder-
CreditHoldAlert; CustomerShipmentAlert; DC-
ShopFloorTransactionErrorAlert; JobMaterial-
CostAlert; JobOperationHoursAlert; JobOverPro-
ductionAlert; JobProjectedLateForCustomerAlert;
LateOrderShippingAlert;LeadAssignedAlert;
LockedUserAlert; OpportunityDueAlert; OverBud-
getAlert; ProjectedLateShipAlert; Prospectinterac-
tionFollowupAlert; ScheduledMainte-
nanceAddedAlert; ScheduledMaintenanceAlert;
TransactionAmountAlert

* Print the Purchase Order Report
* Print a Change Order Report

* Print the Purchase Order Report

* Print the Builder Purchase Order Report

* Change the Purchase Order status to Complete
* Print a Change Order Report

Acknowledge the receipt of a Quote from an exter-
nal application.

Change the Estimate status to Quoted

* Generate an invoice for customers with an 'Open
Item' balance method. The status is set as Open.

* Generate a debit memo/finance charge for cus-
tomers with an 'Open Item' balance method. The
status is set as Open.

* Make a payment and apply it to an invoice for
customers with an 'Open Items' balance method.
The status changes to Paid.

* Generate a credit memo and attach it to an in-
voice for customers with an 'Open ltem' balance
method. This changes the status to Paid.

(For bullet points 2, 3, and 4: If all or part of the
debit memo/finance charge, payment, or credit
memo is left unapplied, a second BOD is generat-
ed. Similar transactions are grouped and shown
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Verb

Sync

Sync

Sync

Acknowledge

Sync

Acknowledge

Sync

Sync

Sync

Acknowledge

Noun

ReceiveDelivery

RemittanceAdvice

RemitToPartyMaster

Requisition

Requisition

SalesOrder

SalesOrder

SecurityPermissionMaster

SecurityRoleMaster

SecurityUserMaster

User action to generate the BOD

under an invoice number '0' with a status of Unap-
plied Cash.)* Create an invoice, payment, credit
memo, debit memo or finance charge transaction
for a customer with a 'Balance Forward' balance
method. The system maintains one balance under
invoice number '0'. Its status is set as follows: for
a debit balance, the status is set as Paid; for a
credit balance, the status is set as UnappliedCash.

* Perform material transactions that add inventory
tied to these types of orders: Project, Job, Cus-
tomer Order (with a negative quantity), Purchase
Order, RMA, Production Order or Transfer Order
that cause a material transaction to occur

* Run the Multi-Site Quantity Move utility

* Post a payment from any of these forms: A/P
Check Printing/Posting, A/P Draft Printing/Posting,
A/P EFT Posting, A/P Wire Posting, or Print/Post
Payroll Checks

* Add or update Vendor information

* Update the vendor's address information

* Update Bank Address information

Acknowledge receipt of a Requisition from an ex-
ternal application

* Print the requisition on either the Purchase
Requisition Report or the PO Requisition Report
forms

* Convert a requisition to a purchase order

* Convert additional items on an existing requisi-
tion (in this case, another BOD is created, replac-
ing the original BOD)

Acknowledge the receipt of a SalesOrder from an
external application

* Print the Customer Order Verification Report
* Change order header status to Completed

Add, delete or change the objects that a group or
user can access.

Add or delete a Group Authorization or change
the group description.

Acknowledge the receipt of a SecurityUserMaster
from an external application.
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Verb

Process

Sync

Sync

Process

Sync

Acknowledge

Acknowledge

Sync

Sync

Sync
Sync

Noun

SecurityUserMaster

ServiceOrder

ShipFromPartyMaster

Shipment

Shipment

ShipmentSchedule

ShipToPartyMaster

ShipToPartyMaster

SourceSystemGLMovement

SourceSystemJournalEntry

SupplierPartyMaster

User action to generate the BOD

Add or change the user status, user description
or workstation login.

Add or update Service Order or Service Order
Operations or Lines.

* Add or update Vendor information

* Update the vendor's address information

* Update Bank Address information

* For customer orders or lines that are assigned
to the local site and that are assigned to an exter-

nal controlled warehouse, print the Order Verifica-
tion Report.

* For transfer orders or lines where the Ship From
site is the local site and the Ship From warehouse
is an external controlled warehouse, print the
Transfer Order Report.

* Perform material transactions that remove inven-
tory tied to these types of orders: Project, Job,
Customer Order, Purchase Order (with a negative
quantity), RMA, Production Order or Transfer Or-
der

* Run the Multi-Site Quantity Move utility

Acknowledge the receipt of a ShipmentSchedule
from an external application

Acknowledge the receipt of a ShipToPartyMaster
from an external application

* Change any information on the Customers form,
Ship Tos form, or Customer Sales Contact Cross
References form

* Run the Change Reports To Entity utility

* Run the Copy Balances to Budgets utility

* Modify Chart of Accounts Budget and Plan infor-
mation

* Run the Rebalance Ledger Period Totals utility
* Run Ledger Posting for Journals
* Run the Mass Journal Posting utility

* Post journal entries to a ledger

* Add or update Vendor information
* Update the vendor's address information
* Update Bank Address information
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Verb Noun User action to generate the BOD
Sync Transfer * Perform a Transfer Order Ship

* Perform a Transfer Order Receive

* Perform a Combined Transfer Order Ship/Re-
ceive

Sync WorkCenter Add a Work Center
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Inbound BOD usage

This table shows the incoming BODs that CloudSuite Business can accept. It also indicates, when
possible, what area of CloudSuite Business shows the processed inbound data.

Verb
Load

Process

Process
Sync

Process
Process
Process
Process
Process

Sync

Sync

Sync

Sync

Process

Process

Sync

Noun

BankStatement

BillOfMaterials

BillToPartyMaster
CaptureDocument
ChartOfAccounts
CodeDefinition

ContactMaster
CurrencyExchangeRateMaster
CustomerPartyMaster

EmployeeTimesheet

ExpenseReport

InventoryAdjustment

InventoryCount

ItemMaster

PayableTransaction

PlanningSchedule

Destination of processed data in Cloud
Suite Business

Bank Statements form, and A/P automatic
payments generated

Engineering Workbench, Current Opera-
tions, Engineering Board

Customers form and related forms
tmp_voucher_builder table

chart table

Depends on type of code
Contacts form and related forms
currate table

Customers form and related forms

Service order transactions, attendance,
project Labor transactions, unposted job
transactions (Indirect, Run or Setup)

prtrx table

Miscellaneous Receipt and Miscellaneous
Issue forms

Miscellaneous Receipt and Miscellaneous
Issue forms

Items form and related forms

Updates Vendor Paid YTD, Paid Fiscal
YTD and Last Paid Date

coitem table (blanket items)
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Verb Noun
Process ProductionOrder
Process Quote

Acknowledge  PulseAlert

Process ReceivableTransaction
Sync ReceiveDelivery
Process Requisition

Process SalesOrder

Sync SecurityUserMaster

Acnowledge Shipment

Sync Shipment
Sync ShipmentSchedule
Process ShipToPartyMaster

Destination of processed data in Cloud
Suite Business

job table

Estimates form and related forms

N/A

Updates Customer Posted Balance

If Type="Transfer” and Status="Received”

create transfer order receipt.

If Type="Purchase Order” and Status="Re-
ceived’create PO receipt

If Type="Customer Return” create RMA
receipt

If Type="Sales Order” create negative CO
receipt.

preq table

Customer Orders form and related forms

coitem or trnitem table (depending on
record type), last_external_ship-
ment_doc_id

If Type=“Transfer” and Status="Shipped”
create Transfer Order Shipment

If Type=“Purchase Order” create Pur-
chase Order Return

If Type=“Sales Order” and Sta-
tus="Shipped” create Customer Order
Shipment

coitem or trnitem table (depending on
record type), last_external_ship-
ment_doc_id

coitem table (blanket items)

Customer Ship Tos form and related
forms
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BODs used in integrations with this
application

This section contains the list of BODs that are available for integrations with CloudSuite Business.

Outbound BODs from the ERP to integrated
applications

This table shows the BODs that are available with CloudSuite Business. Where the application is blank,
the BOD is not currently used by interfacing applications, but the BOD is generated by CloudSuite
Business and is available to be processed through ION and any application that is set up to receive it.

Verb Noun To applications
Sync AccountingChart d/EPM
Sync AccountingEntity d/EPM
Process AdvanceShipNotice SCE Warehouse Management
Acknowledge BillOfMaterials PLM Accelerate
Acknowledge BillToPartyMaster Infor Back Office Connect
Sync BillToPartyMaster CPQ/EQ
CRM

e-Commerce
Infor Back Office Connect
SCE Warehouse Management

Sync ChartOfAccounts d/EPM

Sync CodeDefinition CPQ/EQ
CRM
d/EPM
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BODs used in integrations with this application

Verb

Sync

Process

Sync

Sync

Sync

Acknowledge

Sync

Sync

Acknowledge

Sync

Sync
Sync

Noun

ContactMaster
CurrencyExchangeRateMaster
Sync

CustomerPartyMaster

CustomerPartyMaster

CustomerReturn

Invoice

ItemMaster

ItemMaster

Location

PayFromPartyMaster

PayFromPartyMaster

Person

Personnel

To applications

Expense Management
Infor Back Office Connect
PLM Accelerate

CRM
Infor Back Office Connect

CPQ/EQ
Expense Management

Infor Back Office Connect

CPQ/EQ

CRM

e-Commerce

Infor Back Office Connect
PLM Accelerate

SCE Warehouse Management

CRM
Infor Back Office Connect

CRM
e-Commerce
Infor Back Office Connect

PLM Accelerate

CPQ/EQ

CRM

e-Commerce

Infor Back Office Connect
PLM Accelerate

SCE Warehouse Management

CRM
e-Commerce
Infor Back Office Connect

Infor Back Office Connect

CRM
Infor Back Office Connect

CRM

Expense Management
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BODs used in integrations with this application

Verb
Sync
Sync
Process

Sync

Sync

Sync

Sync
Sync
Acknowledge

Sync

Sync
Process
Sync
Sync
Process

Sync

Sync

Sync

Sync
Sync

Noun
ProductionOrder
ProjectMaster
PulseAlert

PurchaseOrder

Quote

ReceivableTransaction

ReceiveDelivery
RemittanceAdvice
Requisition

SalesOrder

SecurityRoleMaster
SecurityUserMaster
ServiceOrder
ShipFromPartyMaster
Shipment

Shipment

ShipToPartyMaster

SourceSystemGLMovement

SourceSystemJournalEntry

SupplierPartyMaster

To applications
Expense Management
Expense Management
Infor Ming.le

EAM
SCE Warehouse Management

CRM
Infor Back Office Connect

CRM
Infor Back Office Connect

EAM
Expense Management
EAM

CRM
e-Commerce
Infor Back Office Connect

Infor Ming.le

Infor Ming.le

Expense Management

SCE Warehouse Management
SCE Warehouse Management

CRM
e-Commerce
Infor Back Office Connect

CPQ/EQ

CRM

e-Commerce

Infor Back Office Connect
SCE Warehouse Management

d/EPM
d/EPM

EAM
PLM Accelerate
SCE Warehouse Management
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BODs used in integrations with this application

Verb
Sync

Noun

WorkCenter

To applications

PLM Accelerate

Inbound BODs to the ERP from integrated applications

This table shows the BODs that can be received and processed by CloudSuite Business. Where the
application is blank, the BOD is not currently used by integrating applications.

Verb
Process

Process

Process

Process

Process

Sync

Sync

Sync

Sync
Process
Acknowledge

Process

Sync
Process

Process

Sync
Acknowledge

Sync

Noun
BillOfMaterials
BillToPartyMaster

CodeDefinition

ContactMaster

CustomerPartyMaster

EmployeeTimesheet
ExpenseReport
InventoryAdjustment
InventoryCount
ItemMaster
PulseAlert

Quote

ReceiveDelivery
Requisition

SalesOrder

SecurityUserMaster
Shipment
Shipment

From applications
PLM Accelerate

CRM
Infor Back Office Connect

Infor Back Office Connect

CRM
Infor Back Office Connect

CRM
Infor Back Office Connect

Expense Management
Expense Management

SCE Warehouse Management
SCE Warehouse Management
PLM Accelerate

Infor Ming.le

CRM
CPQ/EQ

SCE Warehouse Management
EAM

CPQ/EQ
CRM
e-Commerce

Infor Ming.le
SCE Warehouse Management

SCE Warehouse Management
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BODs used in integrations with this application

Verb Noun From applications

Process ShipToPartyMaster CRM
Infor Back Office Connect
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BODs used in integrations with this application
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